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Workshop Introduction

C2000 Microcontroller 1-Day Workshop

C2000 Technical Training

C2000 is a trademark of Texas Instruments.

i
Copyright © 2016 Texas Instruments. All rights reserved. {‘ TEXAS INSTRUMENTS

Outline

Outline

¢ Workshop Introduction
& Architectural Overview

¢ Programming Development Environment
¢ Lab 1: Using Code Composer Studio with the F2837xD
¢ Reset, Interrupts and System Initialization
¢ Analog Subsystem
¢ Lab 2: Configuring the ADC as a data acquisition system
¢ Control Peripherals
¢ Lab 3: Generating a PWM waveform
¢ Inter-Processor Communications (IPC)
¢ Lab 4: Data transfer using Inter-Processor Communications

¢ Support Resources

i3 TEXAS INSTRUMENTS
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Required Workshop Materials

Required Workshop Materials

@ http://processors.wiki.ti.com/index.php/
C2000_One-Day_Workshop

¢ F28379D LaunchPad auncHxL-F28379D)
¢ Install Code Composer Studio v6.2.0

¢ Run the workshop installer

C2000 MCU 1-Day Workshop-2.0-Setup.exe
¢Lab Files / Solution Files

¢ Student Guide

F28379D LaunchPad

F28379D LaunchPad

JP3:5V JP2:GND D10: GPIO31 (blue) S1: Boot TMS320F28379D

fromUSB from USB . Modes
(disables (disables D9 GP1O34 (red)
isolation) isolation) D1: Power (green)  32/34 * S3: Reset J6/J8 *
Py J14:
QEP_A
Se J15:
[ox3) "
g)g QEP_B
Q% 4
£
o J12:
CAN

CON1:USB  JP1:33v  J1/33* J21 J20/J19

L JP4/JP5 J5/37* J13/J11
emulation/  from USB (ADC-D (Optional SMA (connects 12C
UART (disables differential connector point) 3.3V/5V
isolation) pair inputs) to J5/J7)

* = BoosterPack plug-in module connector Note: F28379D - 337 pin package

C2000 MCU 1-Day Workshop
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F28x7x Piccolo / Delfino Comparison

F2807x [ F2837xS / F2837xD Comparison

F2807x F2837xS F2837xD
C28x CPUs 1 1 2
Clock 120 MHz 200 MHz 200 MHz
Flash / RAM / OTP 256Kw / 50Kw / 2Kw 512Kw / 82Kw / 2Kw 512Kw / 102Kw / 2Kw
On-chip Oscillators v v v
Watchdog Timer v 4 v
ADC Three 12-bit Four 12/16-bit Four 12/16-bit
Buffered DAC 8 3 3
Analog COMP w/DAC v v v
FPU v v v (each CPU)
6-Channel DMA v v v (each CPU)
CLA v v v (each CPU)
VCU / TMU -1 v I v | v (each CPU)
ePWM / HRPWM vy v IV Y|V
eCAP / HRCAP v /- v /- vi-
eQEP v v v
SCI/SPI/12C VY vIviIY viIiYIv
CAN /McBSP /USB VY vVIvivy viIYIv
UuPP v 4
EMIF 1 2 2

F2806x / F2833x / F2837xD Comparison

F2806x F2833x F2837xD
C28x CPUs 1 1 2
Clock 90 MHz 150 MHz 200 MHz
Flash / RAM / OTP 128Kw / 50Kw / 1IKw 256Kw / 34Kw / 1Kw 512Kw / 102Kw / 2Kw
On-chip Oscillators v v
Watchdog Timer v v v
ADC One 12-bit (SOC) One 12-bit (SEQ) Four 12/16-bit (SOC)
Buffered DAC 3
Analog COMP w/DAC v v
FPU v v v’ (each CPU)
6-Channel DMA v v v’ (each CPU)
CLA v v’ (each CPU)
VCU / TMU v /- -/- v | v (each CPU)
ePWM / HRPWM viv VI Y Iv
eCAP / HRCAP Vi vi- V-
eQEP v v v
SCI/SPI/I12C vIvVIvY vIiviIYy VIivIY
CAN /McBSP / USB vIVIY vIYI- VIV
UPP 4
EMIF 1 2
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Architectural Overview

F2837xD Block Diagram

| eounewn |

16-12-bit ADC
xd

Program Bus

TMS320F28x7x Core Block Diagram

l } l S ePWM |
POt 1 | sectored | | pay PMA L.
ROM 6 Ch.

Fesh
IDMA Bus <] ADC
CLA Bus DAC
@ EMIF|
1 CMPSS
l PIE . McBSP |<—»
32x32 bit| |R-M-W T™U :\r/}terrupt
Multiplier| |Atomic CLA anager 2C
FPU || ALU |[VCU 3 Scl
I - I I Watchdog 32b't SP!
Register Bus s CAN 2.0B
CPU
USB 2.0
Data Bus GPIO

C2000 MCU 1-Day Workshop
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Program Bus

CLA Bus

=

¥

32x32 bit | |R-M-W
Multiplier| [Atomic
FPU ALU
P 1
Register Bus 3
CPU [ 32°pit
[Timers

i

Data Bus

F28x CPU + FPU + VCU + TMU and CLA

¢ MCU/DSP balancing code density &
execution time
¢ 16-bit instructions for improved code density
¢ 32-bit instructions for improved execution time
¢ 32-bit fixed-point CPU + FPU
¢ 32x32 fixed-point MAC, doubles as dual
16x16 MAC
¢ |EEE Single-precision floating point
hardware and MAC
¢ Floating-point simplifies software
development and boosts performance

< Viterbi, Complex Math, CRC Unit (VCU)
adds support for Viterbi decode, complex
math and CRC operations

¢ Parallel processing Control Law Accelerator
(CLA) adds IEEE Single-precision 32-bit
floating point math operations

¢ CLA algorithm execution is independent of
the main CPU

¢ Trigonometric operations supported by TMU
¢ Fast interrupt service time
# Single cycle read-modify-write instructions

Simplified F28x7x Memory Map

Simplified F28x7x Memory Map

0x000000
MO RAM (1Kw)
0X000400
M1 RAM (1Kw)
0Xx000D00
0X001480
CLA to CPU MSG
0x001500 | —RAM (128W)
CPU to CLA MSG
RAM (128w)
0x002000
EMIF-2 (4Kw)
0X008000 1= o5 'S5 RAM
OX00B000 (2Kw each)
. DO — DL RAM
(2Kw each)

0x00C000
GS0 - GS15
RAM (4Kw each) SO LS5 RAM
0x03F800 accessible by
CPU2 to CPU1 IPC CPU & CLA
OO0 G0 G PG
0
GS0 - GS15
MSG RAM (1Kw) and EMIFL

0x078000

0x080000

0x100000 F2807x
EMIF-1 (2.9Mw) 2. IPC MSG RAMs
only on F2837xD
0x3F8000 3. 512Kw FLASH on
X Boot ROM (32Kw) F2837xS
Ox3FFFCO

User OTP (1Kw)

accessible by DMA
(only GSO - GS7
RAM on F2807x)

FLASH (256Kw)

Notes:
1. Only EMIF-1 on

BROM Vectors (64w)

C2000 MCU 1-Day Workshop
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Interrupt Response Manager

F28x Fast Interrupt Response Manager

¢ 192 dedicated PIE
vectors
¢ No software decision

PIE module
For 192

192

28x CPU Interrupt logic

making required © g
. < INT1 to
¢ Direct access to RAM |8 e
n
vectors ? 192 = 12 interrupts R ER || INTM (z;gﬁ
¢ Auto flags update 3 : :\/,\
c Register
¢ Concurrent auto s Map
[
context save §
[
o

Auto Context Save

T STO —
AH AL

PH PL

AR1 (L) | ARO (L)

DP ST1

DBSTAT | IER

PC(msw)| PC(Isw)

Direct

Memory Access (DMA)

Direct Memory Access (DMA)

[ PE |
i\ DINTCH1-6 !
ADC | T Pl
—
Result 0-15 »| MCBSP [«——
DMA 14 » SPl|—
GS0 RAM p| 6-channels
: Triggers » PWM1 ——
GS15 RAM I > PWM2
> . —
ADCA/B/C/D (1-4, EVT) > . .
IPC RAM |« MXEVTA/B MREVTA/B <
XINT1-5 TINTO-2 » PWM1l —
ePWM1-12 (SOCA-B) » PWM12 ——
SD1FLT1-4 SD2FLT1-4
EMIF < SPITX/RX (A-C)
USBA_EPX_RX/TX1-3
software

Transfers data between peripherals and/or
memory without intervention from the CPU

10
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Control Law Accelerator (CLA)

Control Law Accelerator (CLA)

— ADC C28x CPU —

W\f\/ = & PWM— T
— —
—lcmp CLA —

¢ The CLA is a 32-bit floating-point processor that
responds to peripheral triggers and executes
code independent of the main CPU

¢ Designed for fast trigger response and oriented
toward math computations

¢ Direct access to ePWM, HRPWM, eCAP, eQEP,
ADC result, CMPSS, DAC, SDFM, SPI, McBSP, and
uPP registers

¢ Frees up the CPU for other tasks
(communications and diagnostics)

Viterbi / Complex Math Unit (VCU)
Viterbi / Complex Math Unit (VCU-II)

Extends C28x instruction
set to support:

VCU execution
. . . < i =
# Viterbi operations el e VCU-Il
. . VSTATUS
¢ Decode for communications _
¢ Complex math VRO 1
& 16-bit fixed-point complex FFT VR1 e
+ used in spread spectrum . VR2 = 3. Arithmetic instructions
commuieators, g many sonal | | g (N 1 o st
¢ Complex filters VRAT [ Vsvea | [*= S G
# used to improve data reliability, RS
transmission distance, and power VR6
efficiency -
¢ Power Line Communijcations
(PLC) and radar applications U p—
. %3 |g|(l:(): Redundancy Check - === Control Logic
=
¢ Communications and memory VI
robustness checks
¢ Other: OFDM interleaving & "’

de-interleaving, Galois Field
arithmetic, AES acceleration

C2000 MCU 1-Day Workshop 11



Architectural Overview

Trigonometric Math Unit (TMU)

Trigonometric Math Unit (TMU)

Adds instructions to FPU for
calculating common
Trigonometric operations

r* sin(rad)

X =r*cos(rad
Operation Instruction Exe Cycles | Result Latency | FPU Cycles w/o TMU
Z=YIX DIVF32 Rz,Ry,Rx 1 5 24
Y = sqrt(X) SQRTF32 Ry, Rx 1 5 ~26
Y = sin(X/2pi) SINPUF32 Ry, Rx 1 4 ~33
Y = cos(X/2pi) COSPUF32 Ry ,Rx 1 4 ~33
Y = atan(X)/2pi | ATANPUF32 Ry, RX 1 4 53
Instruction To QUADF32 Rw,Rz,Ry,Rx 3 11 ~90
Support ATAN2 | ATANPUF32  Ra,Rz
Calculation ADDF32 Rb,Ra,Rw
Y = X * 2pi MPY2PI1F32 Ry, Rx 1 2 4
Y = X*1/2pi DIV2PIF32 Ry, RX 1 2 4

¢ Supported by natural C and C-intrinsics

+ Significant performance impact on algorithms such as:

e Park/ Inverse Park * DQO Transform & Inverse DQO
« Space Vector GEN * FFT Magnitude & Phase Calculations

External Memory Interface (EMIF)

External Memory Interface (EMIF)

¢ Provides a means for the CPU, DMA, and CLA to connect
to various memory devices
¢ Support for synchronous (SDRAM) and asynchronous
(SRAM, NOR Flash) memories
& F2837xD includes two EMIFs
¢ EMIF1 - 16/32-bit interface shared between CPU1 and CPU2
¢ EMIF2 — 16-bit interface dedicated to CPU1

CPU1

. CPU1 .
<:>CPU1'DMA1 Arbiter/ Ilr?tgrzfa%g <:> Arbiter/ Inltg;%ée
P2 Memory K= EMIFLC———> Memory [~ EMIF2
<:>Protection CPU1.CLAL, |Protection
CPU2.DMA1 <:>
—
EMIF1 shared between CPU1 & CPU2 EMIF2 dedicated to CPU1

12 C2000 MCU 1-Day Workshop
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Communication Peripherals

Communication Peripherals

¢ Four Serial Communication Interfaces (SCI)
with 16-level deep TX/RX FIFOs

¢ Three Serial Peripheral Interfaces (SPI) with
16-level deep TX/RX FIFOs

¢ Two Inter-Integrated Circuit Interfaces (12C)
with 16-level deep TX/RX FIFOs

¢ Two Multi-channel Buffered Serial Ports
(McBSP) with double-buffered TX and triple-
buffered RX

¢ Two Controller Area Network Ports (CAN)
with 32 mailboxes each

¢ One USB + PHY port

On-Chip Safety Features

On-Chip Safety Features

¢ Memory Protection
¢ ECC and parity enabled RAMs, shared RAMs protection
¢ ECC enabled flash memory
¢ Clock Checks
¢ Missing clock detection logic
¢ PLLSLIP detection
¢ NMIWDs
¢ Windowed watchdog
¢ Write Register Protection
¢ LOCK protection on system configuration registers
¢ EALLOW protection
¢ CPU1 and CPU2 PIE vector address validity check
¢ Annunciation

¢ Single error pin for external signalling of error

C2000 MCU 1-Day Workshop 13
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Programming Development Environment

Programming Model

Register Programming Model

[ Software
A\ 4
&
= v
Z Bit Fields
§—<
§ v
E Direct
A 4 A 4 A 4
[ Registers and Addresses ]
e e
[ Hardware

¢ DriverLib
¢ Cfunctions automatically set
register bit fields
¢ Common tasks and
peripheral modes supported
¢ Reduces learning curve and
simplifies programming
¢ Bit Field Header Files
¢ C structures — Peripheral
Register Header Files
¢ Register access whole or by
bits and bit fields are
manipulated without masking

¢ Ease-of-use with CCS IDE
¢ Direct Register Access

¢ User code (C or assembly)
defines and access register
addresses

Programming Model Comparison

[Direct Register Access]—

Register addresses # defined individually
User must compute bit-field masks
Not easy-to-read

*CMPR1 = 0x1234;

[ Bit Field Header Files ]—

*
*
*

Header files define all registers as structures
Bit-fields directly accessible
Easy-to-read

EPwmlRegs.CMPA_half.CMPA = EPwmlRegs.TBPRD * duty;

[ DriverLib

]_

¢ DriverLib performs low-level register manipulation
¢ Easy-to-read
¢ Highest abstraction level

EPWM_setCounterCompareValue(EPWM2_BASE, EPWM_COUNTER_COMPARE_A, duty);

¢ The device support package includes documentation and examples showing how to

use the Bit Field Header Files or DriverLib

¢ Device support packages located at: C:\TI\controlSUITE\device_support\
¢ controlSUITE can be downloaded at www. ti .com\controlSUITE

14
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Programming Development Environment

Code Composer Studio

Code Composer Studio™ (CCS) is an integrated development environment (IDE) for Texas
Instruments (Tl) embedded processor families. CCS comprises a suite of tools used to develop
and debug embedded applications. It includes compilers for each of TlI's device families, source
code editor, project build environment, debugger, profiler, simulators, real-time operating system
and many other features. The intuitive IDE provides a single user interface taking you through
each step of the application development flow. Familiar tools and interfaces allow users to get
started faster than ever before and add functionality to their application thanks to sophisticated
productivity tools.

Code Composer Studio: IDE

5 CC5 it - Code Composer Studio =
Fle Edt Vew Navigste Project Soph fun Window help
Byoeidy i B || M conEdt By, 0o Debug

Example_CPUL [Active - Debug]
Incudes

¢ Integrates: edit, code generation,
and debug

¢ Single-click access using buttons

¢ Powerful graphing/profiling tools

¢ Automated tasks using Scripts

¢ Based on the Eclipse open source

software framework

CCS is based on the Eclipse open source software framework. The Eclipse software framework
was originally developed as an open framework for creating development tools. Eclipse offers an
excellent software framework for building software development environments and it is becoming
a standard framework used by many embedded software vendors. CCS combines the
advantages of the Eclipse software framework with advanced embedded debug capabilities from
Tl resulting in a compelling feature-rich development environment for embedded developers.
CCS supports running on both Windows and Linux PCs. Note that not all features or devices are
supported on Linux.

Software Development and COFF Concepts

In an effort to standardize the software development process, Tl uses the Common Object File
Format (COFF). COFF has several features which make it a powerful software development
system. It is most useful when the development task is split between several programmers.

Each file of code, called a module, may be written independently, including the specification of all
resources necessary for the proper operation of the module. Modules can be written using CCS
or any text editor capable of providing a simple ASCII file output. The expected extension of a
source file is . ASM for assembly and .C for C programs.

C2000 MCU 1-Day Workshop 15
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CCS - Software Development

— | Bulld ~—~ ———! _| Code
' | compile Ink.cmd | Simulator
i | i || Development
| Asm [ Link f' Debug lce
_________________________ -I““‘ 1 N External
Editor Libraries | | Graphs, Emulator
Profiling i
MCU
Board

¢ Code Composer Studio includes:
¢ Integrated Edit/Debug GUI
¢ Code Generation Tools
¢ TI-RTOS

CCS includes a built-in editor, compiler, assembler, linker, and an automatic build process.
Additionally, tools to connect file input and output, as well as built-in graph displays for output are
available. Other features can be added using the plug-ins capability

Numerous modules are joined to form a complete program by using the linker. The linker
efficiently allocates the resources available on the device to each module in the system. The
linker uses a command (.CMD) file to identify the memory resources and placement of where the
various sections within each module are to go. Outputs of the linking process includes the linked
object file (-OUT), which runs on the device, and can include a -MAP file which identifies where
each linked section is located.

The high level of modularity and portability resulting from this system simplifies the processes of
verification, debug and maintenance. The process of COFF development is presented in greater
detail in the following paragraphs.

The concept of COFF tools is to allow modular development of software independent of hardware
concerns. An individual assembly language file is written to perform a single task and may be
linked with several other tasks to achieve a more complex total system.

Writing code in modular form permits code to be developed by several people working in parallel
so the development cycle is shortened. Debugging and upgrading code is faster, since
components of the system, rather than the entire system, is being operated upon. Also, new
systems may be developed more rapidly if previously developed modules can be used in them.

Code developed independently of hardware concerns increases the benefits of modularity by al-
lowing the programmer to focus on the code and not waste time managing memory and moving
code as other code components grow or shrink. A linker is invoked to allocate systems hardware
to the modules desired to build a system. Changes in any or all modules, when re-linked, create
a new hardware allocation, avoiding the possibility of memory resource conflicts.
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Edit and Debug Perspective

A perspective defines the initial layout views of the workbench windows, toolbars, and menus that
are appropriate for a specific type of task, such as code development or debugging. This
minimizes clutter to the user interface.

Edit and Debug Perspective

¢ Each perspective provides a set of functionality
aimed at accomplishing a specific task

¢ Edit Perspective ¢ Debug Perspective

+ Displays views used + Displays views used for
during code development debugging
+ C/C++ project, editor, etc. + Menus and toolbars

associated with debugging,
watch and memory
windows, graphs, etc.

C2000 MCU 1-Day Workshop
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Target Configuration

A Target Configuration tells CCS how to connect to the device. It describes the device using GEL
files and device configuration files. The configuration files are XML files and have a *.ccxIm file

extension.
Creating a Target Configuration
ol

Target Configuration

Create a new Target Configuration fle.

¢ File 2 New - Target

File name: | F2837xD.coml

Te—— Configuration File
Location: | C:/Users/<Name=/ti/CCSTargetConfigurations File System. ., | iWorkspace..
@

il *F2837xD.cciml B

Basic

General Setup Advanced Setup

This section describes the general configuration about the target.
Confction Texas Instruments XDE100v2 USE Debug Probe =] Target Configuration

Board or Devie [F753790 save confiquration. @ Select device
£
Test Conmection

To test a connection,
confiquration fie cont

¢ Select connection type

¢ Save configuration
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CCS Project and Build Options

CCS works with a project paradigm. Essentially, within CCS you create a project for each
executable program you wish to create. Projects store all the information required to build the
executable. For example, it lists things like: the source files, the header files, the target system’s
memory-map, and program build options.

CCSv6 Project

I Project Explorer &3 St b ]
T T — Project files contain:

[ g 2837x_RAM_Ink_cpul.cmd
- [.€] Example_CPU1.c
[#| g F2837%_Headers_nonBIOS_cpul.cmd

E] F2837%D_CodeStartBranch.asm ‘ LlSt Of f||es'

- [€] F2837%D_DefaultisR.c
- [€] F2a37%D_GlobalvariableDefs.c

e ¢ Source (C, assembly)
(-] F2837xD_Ipc_Driver_Utl.c . .
W[ F2837D_Ipc.c * lel’arleS
[ [€ F2837%D_PieChrl.c

1-[2] F28370_pieect.c ¢ SYS/BIOS configuration file

B [€] F2837D_SysCirl.c
- [S] F2837%D_usDelay.asm . .
EHE Example_CPUZ ¢ Linker command files
-5l Includes

o G 2857 Rav bk oz ¢ Project settings:

3l lﬂ Example_CPU2.c

f{  F2837x_Headers_nonBIOS_cpu2.cmd 'S B u | | d 0 pt | ons (CO m p | | er,

£ F2837xD_CodeStartBranch.asm

{-[@ F2837D_ DefaultSR.C assembler, linker, and
- [€] F2837%D_GlobalVariableDefs.c TI_ RTOS)

[
2
k
[
&
[
£
B-[£] F2837xD_Gpio.c
£
[
[
B
[
[

A ¢ Build configurations
-[€ F2837D_PieCtrl.c

e

Lc| F2837xD_Pievect.c

F2837xD_SysCirl.c
15| F2837xD_usDelay.asm

3l
al
3l
3l

B

To create a new project, you need to select the following menu items:
File > New = CCS Project

Along with the main Project menu, you can also manage open projects using the right-click popup
menu. Either of these menus allows you to modify a project, such as add files to a project, or
open the properties of a project to set the build options.
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A graphical user interface (GUI) is used to assist in creating a new project. The GUI is shown in
the slide below.

Creating a New CCSv6 Project(s)

¢ File 2 New =2 CCS Project

ol alx]
€5 Project =l €ES Project =l
Create a new CCS Progect (A Create a iew CCS Project -
Target: [ 2837xD Defino | [msazorzmar90 = Taget: | 283740 Defino =] [msa20ez83790 =]

Connectir: | =] Connecuon; | =
i camox [c2o00] | i caax [cz000] |
Project name: | Example_CPUL Project rame: | Exampee_CPUZ
I Use defauit ication L
Location: | C:\FZa37xD\Labs Examgie\opal ] Locaton; | C:\F783 72 DiLabs Exampielpual?
Coempler virsion: [T v15.12.3075 =] Wore. Coenpler verson: [T1 v15.12.3475
+ Advanced settngs + Advanced settngs:
» Project tempistes and examples ¥ Project templates and examples.
v | | mnsh | cance | v | | pnsn Cancel

Advanced Setting / Project Templates and Examples

- Advanced setings = Project temgiates and exancies
Jrvoe f Creates an empty project fully inftalzed for the = |
Output type: [Eennstie = | 3
Outpt format: [ |
-~ ol = & Emoty Assemtsy oniy Project
ek et [ o 7] wowi S Enpty ATSC Prosct
Suritrre mgpert ey [ <o.omencs ] | orowse. 2 5:::”*”
b

Project options direct the code generation tools (i.e. compiler, assembler, linker) to create code
according to your system’s needs. When you create a new project, CCS creates two sets of build
options — called configurations: one called Debug, the other Release (you might think of as
optimize).

To make it easier to choose build options, CCS provides a graphical user interface (GUI) for the
various compiler and linker options. The following slide is a sample of the configuration options.

There is a one-to-one relationship between the items in the text box on the main page and the
GUI check and drop-down box selections. Once you have mastered the various options, you can
probably find yourself just typing in the options.

There are many linker options but these four handle all of the basic needs.

o -0 <FTilename> specifies the output (executable) filename.

o -m <Filename> creates a map file. This file reports the linker’s results.
e —c tells the compiler to autoinitialize your global and static variables.

o -—x tells the compiler to exhaustively read the libraries. Without this option libraries are
searched only once, and therefore backwards references may not be resolved.

To help make sense of the many compiler options, Tl provides two default sets of options (con-
figurations) in each new project you create. The Release (optimized) configuration invokes the
optimizer with —03 and disables source-level, symbolic debugging by omitting —g (which disables
some optimizations to enable debug).

20
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CCSv6 Build Options — Compiler / Linker

Pesisas tptis i

g e e e
¢ Separate build options for each project — CPU1 & CPU2
¢ Compiler

+ Categories for code generation tools — controls many aspects
of the build process, such as:

¢ Optimization level
¢ Target device
¢ Compiler / assembly / link options
¢ Linker
¢ Categories for linking — specify various link options
¢ ${PROJECT_ROOQOT} specifies the current project directory

C2000 MCU 1-Day Workshop 21



Programming Development Environment

CCSv6 Debug Environment

The basic buttons that control the debug environment are located in the top of CCS:

B @- DO @~ e -t P-

e

- AR AL e

The common debugging and program execution descriptions are shown below:

Start debugging

Image

Name

Description

Availability

iﬁi

New Target
Configuration

Creates a new target configuration file.

File New Menu
Target Menu

ﬁ‘g; Debug Qpens a dialog to modify existing debug configura- Debug Toolbar
tions. Its drop down can be used to access other
- . Target Menu
launching options.
51__ Connect Connect to hardware targets. T1 Debug Toolbar
Target Target Menu
Debug View Context Menu
Terminate All | Terminates all active debug sessions. Target Menu

Debug View Toolbar

22
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Program execution

Image Name Description Availability
oo Halt Halts the selected target. The rest of the debug
- - . . Target Menu
views will update automatically with most recent -
Debug View Toolbar
target data.
[ Run Resumes the execution of the currently loaded
. . Target Menu
program from the current PC location. Execution -
. - R Debug View Toolbar
continues until a breakpoint is encountered.
={>I Run to Line Resumes the execution of the currently loaded
. - Target Menu
program from the current PC location. Execution Disassembly Context Menu
continues until the specific source/assembly line is e
Source Editor Context Menu
reached.
q. Go to Main Rups _the programs until the beginning of function Debug View Toolbar
main in reached.
i Step Into Steps into the highlighted statement. Target Menu
Debug View Toolbar
i Step Over Steps over the highlighted statement. Execution
will continue at the next line either in the same
method or (if you are at the end of a method) it Target Menu
will continue in the method from which the current Debug View Toolbar
method was called. The cursor jumps to the decla-
ration of the method and selects this line.
L Step Return | Steps out of the current method. Target Menu

Debug View Toolbar

q& Reset Resets the selected target. The drop-down menu
- . . Target Menu
has various advanced reset options, depending on -
. Debug View Toolbar
the selected device.
,;,1,}'3?4 Restart Restores the PC to the entry point for the currently
loaded program. If the debugger option "Run to
. o . Target Menu
main on target load or restart" is set the target will Debua View Toolbar
run to the specified symbol, otherwise the execu- 9
tion state of the target is not changed.
T Assembly The debugger executes the next assembly instruc- | Tl Explicit Stepping Toolbar
Step Into tion, whether source is available or not. Target Advanced Menu
L) Assembly The debugger steps over a single assembly instruc-
Step Over tion. If the instruction is an assembly subroutine, Tl Explicit Stepping Toolbar

the debugger executes the assembly subroutine
and then halts after the assembly function returns.

Target Advanced Menu

C2000 MCU 1-Day Workshop
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Dual Subsystem Debug
Launching Dual Subsystem Debug ()

¢ 15t subsystem (ccs Edit Perspective) -
#Clicking “Debug” button #|will automatically:
eLaunch the debugger

¢Connects to target
¢Programs flash memory

1 Debug
= W% F2B37xDuconml [Code Composer Studio - Device Debugging]
D

= e_int00() at boot26.nc:248 (xO0030C (the entry pont was reachad)
#® Texas Instruments XDS100v2 USE Debug Probe_O/CPUL_CLAL (Dsconnected : Unknown)
- Texas Instruments XDS100v2 USB Debug Probe_(/C28xx_CPU2 (Deconnected : Unknown)

 Texas Instruments XDS100v2 USB Debug Probe_0/CPUZ_CLAL (Deconnected : Unknown)

¢ Note 2"d subsystem is disconnected
¢ Next step will connect 2"d subsystem

Launching Dual Subsystem Debug )

¢ 2nd subsystem (CCS Debug Perspective) -
¢In Debug window right-click on emulator and
select “Connect target”
¢ Highlight emulator and load program (flash)
¢Run - Load - Load Program...

1 Debug
W F2837xD.ocmi [Code Composer Studio - Device Debugging]
= o Texas Instruments XDS5100v2 USE Debug Probe_0/C28xx_CPUL (Suspended - SW Breakpont)
= main{) at Labl_cpu01.¢:12 (xDOBSCE
= _args_main() at args_main.c:81 0x000698
= c_nto0() 3t boot28 inc:248 x0002DC (the entry pont was reached)
@ Texas Instruments XDS100v2 USB Debrug Probe_0/CPU1_CLAL (Disconnected : Unknewn)
= @ Texas Instruments XDS100v2 USE Debug Probe_o/C28xx_CPUZ (Suspended - SW Breakpoint)
Bl maing) at Labl_cpu02. IB07E
= _args_main() at args_main.c:81 008151
= ¢_nt00() at boot28.nc:248 (n00BTES (the entry point was reached)
+® Texas Instruments ¥DS100v2 USE Debug Probe_0//CPUZ_CLAIL (Dsconnected © Unknown)

¢ Both subsystems are connected
¢ Next step is dual subsystem start-up sequence
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Dual Subsystem Debug Start-up

¢ Start-up sequence
1. Reset CPU1l subsystem
2. Reset CPU2 subsystem
3. Run CPUL subsystem
4. Run CPU2 subsystem
5. Stop and debug either subsystem
¢ Debug window controls “selected”
subsystem for the debug interaction
¢ Highlight appropriate subsystem for debug

¥ Debug 52 0 EM 3| RS T =0
Run e ode Composer Sheiu - Device Debugging]
—Er'gy'-&;s Instrime " aws100v2 155 Emulator_0/CZ@xx_CPL1 (Suspe ided - SW E ‘gakpoil t) Refresh
Halt —_sasdrstruments ¥55100v2 USB Emitiator_0/CPL!'i_CLA1 (Discranected : Unkr 3wn)
-—.?_,-.j:exas Trsiruments XDS 100v2 U5B Emulator G;C28xx_CPU2 (uspended - SW B ‘gkpoint) Restart |
Terminate “astruments XNS100v2 USB Emivluter_0/CPU2_CLA* @isconnected : Unkn )
il /r" | Reset |

Step \ntOJ StevaerJ ASMStepIntOJ ASM StevaerJ SteoReturnJ;

Lab File Directory Structure

Lab File Directory Structure

| F2837%D Supporting Files and Libraries
2 [l Deviee support / ¢ Easier to make projects portable
i3 ¢ ${PROJECT_ROOT} provides
/ F2837xD_common an anchor point for paths to files

. F2837xD_headers that travel with the project
B .} Labs ¢ Easier to maintain and update
= Lk supporting files and libraries

UL Source Files are “Added” to
. cpuz]“/ the Project Folder

Original Source Files

 Lab2 + All modified files are in the
| Lab3 Project Folder
| Lzh4 ¢ Original source files are

always available for reuse, if

J Source_files .
= a file becomes corrupted

Note: CCSv6 will automatically add ALL files contained in the folder where the project is created

C2000 MCU 1-Day Workshop
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Lab 1: Dual-Core Debug with F2837xD

Lab 1. Dual-Core Debug with F2837xD

> Objective

The objective of this lab exercise is to become familiar with the Code Composer Studio (CCS)
development environment while using a dual core F2837xD device. Details on setting up the
target configuration, creating a new project, setting build options, and connecting to the dual-core
device will be explained. A typical F2837xD application consists of two separate and completely
independent CCS projects. One project is for CPU1, and the other project is for CPU2. A project
contains all the files needed to develop an executable output file (.out) which can be run on the
F2837xD device. In this lab exercise we will have CPUL1 blink LED D10 and the CPU2 blink LED
D9.

Labl: Dual-Core Debug with F2837xD

LED D10
LED D9

¢ Use Code Composer Studio (CCS) in
dual-core debug environment
¢ Set up target configuration
¢ Create CPUL1 project
¢ CPUL1 blinks LED D10 (software delay loop)

¢ Load and run CPU2 project
¢ CPU2 blinks LED D9 (software delay loop)

> Initial Hardware Set Up

Note: The lab exercises in this workshop have been developed and targeted for the F28379D
LaunchPad. Optionally, the F28379D Experimenter Kit can be used. Other F2807x or
F2837xS development tool kits may be used and might require some minor modifications
to the lab code and/or lab directions; however the Inter-Processor Communications lab
exercise will require either the F28379D LaunchPad or the F28379D Experimenter Kit.
Refer to Appendix A for additional information about the F28379D Experimenter Kit.

e F28379D LaunchPad:

Using the supplied USB cable — plug the USB Standard Type A connector into the computer USB
port and the USB Mini Type B connector into the LaunchPad. This will power the LaunchPad
using the power supplied by the computer USB port. Additionally, this USB port will provide the
JTAG communication link between the device and Code Composer Studio.

26
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Lab 1: Dual-Core Debug with F2837xD

At the beginning of the workshop, boot mode switch S1 position 3 must be set to “1 — ON". This
will configure the device for emulation boot mode.

> Initial Software Set Up

Code Composer Studio must be installed in addition to the workshop files. A local copy of the
required controlSUITE files is included with the lab files. This provides portability, making the
workshop files self-contained and independent of other support files or resources. The lab
directions for this workshop are based on all software installed in their default locations.

> Procedure

Start Code Composer Studio and Open a Workspace

1. Start Code Composer Studio (CCS) by double clicking the icon on the desktop or selecting it
from the Windows Start menu. When CCS loads, a dialog box will prompt you for the
location of a workspace folder. Use the default location for the workspace and click OK.

This folder contains all CCS custom settings, which includes project settings and views when
CCS is closed so that the same projects and settings will be available when CCS is opened
again. The workspace is saved automatically when CCS is closed.

2. The first time CCS opens, an introduction page appears. Close the page by clicking the X on
the “Getting Started” tab. You should now have an empty workbench. The term “workbench”
refers to the desktop development environment. Maximize CCS to fill your screen.

The workbench will open in the “CCS Edit” perspective view. Notice the CCS Edit icon in the
upper right-hand corner. A perspective defines the initial layout views of the workbench
windows, toolbars, and menus which are appropriate for a specific type of task (i.e. code
development or debugging). This minimizes clutter to the user interface. The “CCS Edit”
perspective is used to create or build C/C++ projects. A “CCS Debug” perspective view will
automatically be enabled when the debug session is started. This perspective is used for
debugging C/C++ projects.

Set Up Target Configuration

3. Open the emulator target configuration dialog box. On the menu bar click:
File > New > Target Configuration File

In the file name field type F2837xD.ccxml. This is just a descriptive hame since multiple
target configuration files can be created. Leave the “Use shared location” box checked and
select Finish.

4. In the next window that appears, select the emulator using the “Connection” pull-down list
and choose “Texas Instruments XDS100v2 USB Debug Probe”. In the “Board or Device” box
type F28379D to filter the options. In the box below, check the box to select “F28379D".
Click Save to save the configuration, then close the “F2837xD.ccxml” set up window by
clicking the X on the tab.

5. To view the target configurations, click:
View > Target Configurations

and click the plus sign (+) to the left of “User Defined”. Notice that the F2837xD.ccxml file is
listed and set as the default. If it is not set as the default, right-click on the .ccxml file and
select “Set as Default”. Close the Target Configurations window by clicking the X on the tab.
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Create a New Project — CPU1

6.

A project contains all the files needed to develop an executable output file (.out) which will run
on the MCU hardware. To create a new project for CPUL1 click:

File > New = CCS Project

A CCS Project window will open. At the top of this window, filter the “Target” options by using
the pull-down list on the left and choose “2837xD Delfino”. In the pull-down list immediately
to the right, choose the “TMS320F28379D"” device.

Leave the “Connection” box blank since we already set up the target configuration.

The next section selects the project settings. In the Project name field type Lab1l_cpuO1.
Uncheck the “Use default location” box. Click the Browse... button and navigate to:

C:\F2837xD\Labs\Labl\cpuOl
Click OK.

Next, open the “Advanced setting” section and set the “Linker command file” to “<none>".
We will be using our own linker command file, rather than the one supplied by CCS.

Then, open the “Project templates and examples” section and select the “Empty Project”
template. Click Finish.

A new project has now been created. Notice the “Project Explorer” window contains

Labl cpuOl. The project is set Active and the output files will be located in the Debug folder.
At this point, the project does not include any source files. The next step is to add the source
files to the project.

Add Files to Project — CPU1

Note: The local copy of the supporting files and libraries in this workshop are identical to the

required controlSUITE files. The workshop lab exercises will make use of these files as
often as possible. When adding files to the project, a window will appear asking to “copy”
or “link” the files. Selecting “Copy files” will make a copy of the original file to work with in
the local project directory. Selecting “Link files” will set a reference to the original file and
will use the original file. Typically, “link files” is used when the files will not be modified.
To avoid accidently modifying the original files, we will use “copy files” throughout this
workshop and work with the local copy in the project directory.

10.

For convenience, all of the needed source files for this lab exercise are located in the same
folder.

To add the source files to the project, right-click on Labl_cpu01 in the “Project Explorer”
window and select:

Add Files..
or click: Project > Add Files..

Navigate to C:\F2837xD\Labs\Source_files. Select all of the files in this folder and
click Open. Next, add (“copy files”) the files to the project by clicking OK. The files used in
this project are:

28
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2837xD_RAM_Ink_cpul.cmd F2837xD_PieCtrl.c
F2837xD_CodeStartBranch.asm F2837xD_PieVect.c
F2837xD_DefaultlISR.c F2837xD_SysCtrl.c
F2837xD_GlobalVariableDefs.c F2837xD_usDelay.asm
F2837xD_Gpio.c Labl cpuOl.c

F2837xD_Headers_nonBIOS_cpul.cmd

In the Project Explorer window, click the plus sign (+) to the left of Labl_cpuO1l1 and notice
that the files are listed.

Project Build Options — CPU1

11. Configure the build options by right-clicking on Lab1_cpu01 in the “Project Explorer” window
and select “Properties”. We need to set up the include search path to include the peripheral
register header files. Under “C2000 Compiler” select “Include Options”. In the search path
box (“Add dir to #include search path”) click the Add icon (first icon with green plus sign).
Then in the “Add directory path” window type (one at a time):

${PROJECT_ROOT}/../../..[Device_support/F2837xD_headers/include
${PROJECT_ROOT}/../..I../IDevice_support/F2837xD_common/include

Click OK to include each search path.

12. Next, we need to configure the predefined symbols. Under “C2000 Compiler” select
“Advanced Options” and then “Predefined Symbols”. In the predefined name box (“Pre-
define NAME?") click the Add icon (first icon with green plus sign). Then in the “Enter Value”
window type (one at atime); CPU1 and LAUNCHXL_F28379D (note leading underscore).
Click OK to include each name. These names are used in the project to conditionally include
the peripheral register header files code specific to CPU1 and the LaunchPad. Finally, click
OK to save and close the Properties window.

Inspect the Project — CPUL1

13. Open and inspect Lab1l_cpu0O1.c by double clicking on the filename in the Project Explorer
window. The code in this lab exercise will be running from internal RAM. In function main(),
the code lines shown below are used to configure the GPIO pins. On the LaunchPad,
GPIO31 and GPIO34 are used to blink LEDs D10 and D9, respectively.

14 // Initialize GPIO

15 InitGpio();

16 EALLOW;

17 GpiocCtrlRegs.GPADIR.bit.GPIO31 = 1;

18 GPIO_SetupPinOptions(34, GPIO OUTPUT, GPIO _PUSHPULL);
19 GPIO SetupPinMux(34, GPIO MUX_CPUZ, @);

20 EDIS;

21 GpioDataRegs.GPADAT.bit.GPIOZ1 = 1; J/f Turn off LED

Since CPUL1 has control over all the 10 pins, GPIO31 can be manipulated directly by CPUL.
However, for this lab exercise, we would like to have CPU2 control GPIO34 so it can blink
D9. This will be accomplished using the IPC (Inter-Processor Communications) module on
the device. The function calls are used here to set up the GPIO pin so it is ready for CPU2
to use.

14. At the bottom of function main() is an infinite “for” loop. The instructions inside the loop blink
LED D10 on the LaunchPad at a rate determined by the DELAY_US() macro. The LED
status is changed by the code lines which write to the GPIO31 pin.
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15. CCS contains an outline viewer which displays the components of each source file. Open the
outline viewer by clicking:

View 2> Outline

Notice that the outline window contents change as each source file is viewed in the editor.
For the source file “Labl_cpu01” the outline window contains:

0= Outline 532 T=
TR o % T
o =l F28x_Project.h

""" ® ToggleCountl : unsigned short
“ee @ mainfyveid) : void

The list is short since this is a very simple project, but for more complex source files the
“Outline” view provides a useful way of finding symbols and function calls within the file.

Open a New Project — CPU2

16. A project named Labl_cpu02 has been created for this lab exercise. Open the project by
clicking on Project - Import CCS Projects. The “Import CCS Eclipse Projects”
window will open then click Browse... next to the “Select search-directory” box. Navigate to:
C:\F2837xD\Labs\Lab1\cpu02 and click OK. Then click Finish to import the project.
All build options have been configured the same as the previous project (CPU1). The files
used in this project are:

2837xD_RAM_Ink_cpu2.cmd F2837xD_PieCtrl.c
F2837xD_CodeStartBranch.asm F2837xD_PieVect.c
F2837xD_DefaultlISR.c F2837xD_SysCtrl.c
F2837xD_GlobalVariableDefs.c F2837xD_usDelay.asm
F2837xD_Gpio.c Labl cpuO2.c

F2837xD_Headers_nonBIOS_cpu2.cmd

Inspect the Project — CPU2

17. Open and inspect Labl_cpu02.c by double clicking on the filename in the Project Explorer
window. The code for CPU2 is almost identical to that for CPU1. One difference is the
timings of the LED status changes at the bottom of main(). Locate these lines. Notice that
the code which toggles the I/O pin uses the function GP10_WritePin(). As mentioned, this
uses the Inter-Processor Communications (IPC) module to send the data from CPU2 to
CPU1, which has control over the GPIO pins.

Build and Load the Projects — CPU1 & CPU2

18. Two buttons on the horizontal toolbar control code generation. Hover your mouse over each
button as you read their descriptions:

R
Button Name Description
1 Build Full build and link of all source files
2 Debug Automatically build, link, load/program and launch debug-session

Note: In CCS the on-chip flash programmer is integrated into the debugger. When the program is
loaded CCS will automatically determine which sections reside in flash memory based on the
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Lab 1: Dual-Core Debug with F2837xD

linker command file. CCS will then program these sections into the on-chip flash memory.
Additionally, in order to effectively debug with CCS, the symbolic debug information (e.g., symbol
and label addresses, source file links, etc.) will automatically load so that CCS knows where
everything is in your code. In this lab exercise, code will be running from RAM only.

19. In the Project Explorer window click on the “Labl1_cpu01” project to set it active. Then click
the “Build” button (hammer) and watch the tools run in the “Console” window. Check for any
errors in the “Problems” window. (Repeat this step for the “Labl_cpu02” project.

20. Again, in the Project Explorer window click on the “Labl1_cpu01” project to set it active. CCS
in the “CCS Edit” perspective view can automatically save modified source files, build the
program, open the “CCS Debug” perspective view, connect and download it to the target
(load RAM memory or program flash memory), and then run the program to the beginning
main(), in a single step.

Click on the “Debug” button (green bug) or click RUN - Debug

A Launching Debug Session window will open. (Select only CPU1 to load the program on,
and then click OK.

The CCS Debug icon in the upper right-hand corner indicates that we are now in the “CCS
Debug” perspective view. The program ran through the C-environment initialization routine in
the run-time support library and stopped at “main()” in Labl _cpu0O1.c. (The blue arrow in the
left hand column of the source code window indicates the current position of the CPU1
program counter (PC). The “Debug” window reflects the current status of CPU1 and CPU2.

%5 Debug 32 ¥ =0
E-%% Labl_cpu0l [Code Composer Studio - Device Debugging]
E|,.§'—‘ Texas Instruments XDS100v2 USB Debug Probe_0/C28xx_CPU1 (Suspended - SW Breakpoint)
IS ain() at Labl_cpu01.c:12 0x00B5CB
_args_main() at args_main.c:81 0x00B698
: . C_int00() at boot28.inc:248 0x0003DC (the entry point was reached)
x@ Texas Instruments XDS100v2 USB Debug Probe_0/CPU1_CLA1 (Disconnected : Unknown)
x‘?—“ Texas Instruments XDS100v2 USB Debug Probe_0/C28xx_CPU2 (Disconnected : Unknown)
x@’ Texas Instruments XDS100v2 USB Debug Probe_0/CPU2_CLA1 (Disconnected : Unknown)

Notice that CPUL1 is currently connected and CPU2 is “Disconnected". This means that CCS
has no control over CPU2 thus far; it is freely running from the view of CCS. Of course CPU2
is under control of CPU1 and since we have not executed an Inter Processor Communication
(IPC) command yet, CPU2 is stopped by an “Idle” mode instruction in the Boot ROM.

21. Next, we need to connect to and load the program on CPU2. (Right-click at the line “Texas
Instruments XDS100v2 USB Debug Probe_0/C28xx_CPU2” and select “Connect Target”.

22. With the line “Texas Instruments XDS100v2 USB Debug Probe 0/C28xx_CPU2" still
highlighted, load the program:

Run -> Load - Load Program..

Browse to the file: C:\F2837xD\Labs\Lab1\cpu02\Debug\Labl cpu02.out and select
OK to load the program.

Debug Environment Windows

It is standard debug practice to watch local and global variables while debugging code.
There are various methods for doing this in Code Composer Studio. Next, we will examine
the use of an “Expressions” window.

23. To add global variables to the “Expressions” window, click the “Expressions” tab near the top
of the CCS window. (Note that the expressions window can be manually opened by clicking:
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Lab 1: Dual-Core Debug with F2837xD

View > Expressions onthe menu bar). In the Expression window an ampersand, which
means the “address of”, is not used. The Expressions window knows we are specifying a
symbol.

24. In main() for each CPU there is a counter which keeps track of the number of times each LED
has changed state. We will monitor these variables. In the empty box in the “Expression”
column (click on the text “Add new expression”), type ToggleCountl and then enter.

25. Repeat the above step to add the variable ToggleCount2 to the Expressions window.

Running the Code — CPU1 & CPU2

Two buttons on the horizontal toolbar are commonly used to control program execution. Hover
your mouse over each button as you read the following descriptions:

Ub=
Button Name Description
1 Resume Run the selected target (F8)
2 Suspend Halt the selected target (Alt+F8)

26. In the Debug window, click on the line “Texas Instruments XDS100v2 USB Debug
Probe_0/C28xx_CPU1". Then run the code on CPUL1 by clicking the green “Resume” button.
LED D10 on the LaunchPad should now be blinking at approximately 1Hz.

27. In the Debug window, click on the line “Texas Instruments XDS100v2 USB Debug
Probe_0/C28xx_CPU2". As before, then run the code on CPU2 by clicking the “Resume”
button. LED D9 should now also be blinking, though at a different frequency than D10.

28. Halt the CPU2 program by clicking on the “Suspend” button. In the Expressions window the
ToggleCount?2 variable should have recorded a small number of LED state changes.
Notice that the ToggleCountl variable is not recognized on CPU2

29. Click on CPUL1 in the Debug window and halt the program using the “Suspend” button.
Again, the ToggleCount1 variable should have a small number while ToggleCount2 is
unrecognized.

In the forthcoming labs we will explore several other features of the CCS environment, including
real-time debugging and the graph plotting capabilities of the software.
Terminate Debug Session and Close Project
30. The “Terminate” button will terminate the active debug session, close the debugger and
return CCS to the “CCS Edit” perspective view.
Click: Run > Terminate or use the Terminate icon: =
31. Next, close the Labl cpu01 and Labl cpu02 projects by right-clicking on each project in the

Project Explorer window and select Close Project.

End of Exercise
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Reset, Interrupts and System Initialization

Reset, Interrupts and System Initialization

Reset Sources

Reset Sources

Missing Clock Detect F28x7X

Watchdog Timer *

Power-on Reset 1)
Hibernate Reset

XRS

XRS pin active

To XRS pin

' . ' ) ) . *=CPULWD resets both cores and
Logic shown is functional representation, not actual implementation CPU2.WD resets CPU2 only

¢ POR - Power-on Reset generates a device reset during
power-up conditions

¢ RESC — Reset Cause register contains the cause of the
last reset (sticky bits maintain state with multiple resets)

Note: Only F2807x devices support an on-chip voltage regulator (VREG) to
generate the core voltage.

Boot Process

Dual-Core Boot Process

¢ CPUL1 starts execution from CPU1 boot
ROM while CPU2 is held in reset

¢ CPU1 controls the boot process
¢ CPU2 goes through its own boot process

under the control of CPU1 — except when
CPU2 is set to boot-to-flash

¢ IPC registers are used to communicate
between CPU1 and CPU2 during the boot
process
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Reset — Bootloader

Reset vector

Reset fetched from
ENPIE =0 boot ROM CPU2 held_lin
— reset unti
LIRS O0x3F FFCO released by
P
ponnnnnennnna » CPU2 |
YES Emulator NO
TRsT=1 | Connected ? | TRsT=0

Emulation Boot
Boot determined by

EMU_BOOTCTRL:
EMU_KEY and EMU_BMODE

TRST = JTAG Test Reset

Stand-alone Boot
Boot determined by
2 GPIO pins and

ZxOTP_BOOTCTRL:
OTP_KEY and OTP_BMODE

EMU_BOOTCTRL register located in PIE RAM at 0xX000D00
Z10TP_BOOTCTRL register located in OTP at 0x07801E
Z20TP_BOOTCTRL register located in OTP at 0x07821E

Emulation Boot Mode

Emulation Boot Mode (TRST=1) side1of2

Emulator Connected
Emulation Boot
Boot determined by
EMU_BOOTCTRL :

If either EMU_KEY or EMU_BMODE
are invalid, the “wait” boot mode is
used. These values can then be
modified using the debugger and a

EMU_KEY and EMU_BMODE reset issued to restart the boot process.
v
| EMU_KEY = Ox5A ? | Booitlec
| Wait
YES
GPIO 72 GPIO 84| Boot Mode
— 0 0 Parallel I/0 | Boot pins can be
EMU_BMODE = 0xFE ? | YES @ a SCLA mapped to any GPIO
CPU1 onl . pins. GetMode reads
y 1 0 Wait ZxOTP_BOOTCTRL
NO 1 1 GetMode (not the boot pins).
YES
EMU_BMODE = OxFF ? | Boot Mode | paaqs OTP for boot
Emulate CPUL/2 | pins and boot mode.
NO Stand-Alone
CPU1 EMU_BOOTCTRL Register CPU2 EMU_BOOTCTRL Register
31-24 23-16 15-8 7-0 31-24 23-16 15-8 7-0
EMU_BOOTPIN1] EMU_BOOTPINO]EMU_BMODE [EMU_KEY | [ reserved reserved  |EMU_BMODE |EMU_KEY
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Continued from
previous slide

Emulation Boot Mode (TRST=1) side2of2

EMU_BMODE = | Boot Mode
0x00 Parallel I/0
0x01 SCI-A
0x03 GetMode

CPU1 0x04 SPI-A

& — | 0x05 12C-A

CPUZ | | ox07 CAN-A
O0x0A MO SARAM
0x0B FLASH
other Wait
0x0C USB-0
0x81 SCI-A *

Gy | oxg4 SPI-A*
0x85 12C-A *
0x87 CAN-A *

* Alternate RX/TX GPIO
pin mapping for CPU1 only

NO | Boot Mode
—»| OTP_KEY = Ox5A ? I e
1 YES

OTP_BMODE = | Boot Mode
0x00 Parallel 1/0
0x01 SCI-A
0x04 SPI-A
0x05 12C-A
0x07 CAN-A
OX0A MO SARAM
0x0B FLASH — ot
0x0C USB-0
other Wait
0x81 SCI-A *
0x84 SPI-A *
0x85 I2C-A *
0x87 CAN-A *
OTP_BMODE = | Boot Mode
0x0B FLASH } CPU2
other Wait GetMode

Stand-Alone Boot Mode

Emulator Not Connected

Stand-Alone Boot Mode (trsT=0)

Stand-al Boot — OTP_BMODE = | Boot Mode
and-alone boo 0x00 Parallel /O
Boot determined by 0x01 SCI-A
2 GPIO pins and 0x04 SPI-A
ZXOTP_BOOTCTRL : 0x05 12C-A
OTP_KEY and OTP_BMODE 0x07 CAN-A
i Ox0A MO SARAM cPUL
GPIO  GPIO 0x0B FLASH ~ GetMode
72 84 Boot Mode 0x0C USB-0
CPU1 0 0 | Parallel I/O other Wait
only 0 1 |scl 0x81 SCI-A *
1 0 Wait 0x84 SPI-A*
1 1 | GetMode 0x85 12C-A *
l—_, 0x87 CAN-A *
Zl%S'I?P Z10TP_BOOTCTRL YES OTP_BMODE = | Boot Mode
soost= 7 | OTP_KEY = 0x5A 2 0x0B FLASH CcPU2
other Wait GetMode
I Nno
Use YES CPU1 ZxOTP_BOOTCTRL Regist
Z20TP_ { é@l.%TE—EE:(O:OOTX%LR?L -24 516 1528 7-0
BOOTCTRL = ’ [OTP_BOOTPIN [OTP_BOOTPINO [OTP_BMODE [OTP_KEY |
NO
l CPU2 ZxOTP_BOOTCTRL Register
Boot Mode 31-24 23-16 15-8 7-0
FLASH | reserved | reserved [OTP_BMODE [OTP_KEY|
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Reset Code Flow — Summary

Reset Code Flow - Summary

0x000000

0x000000
MO SARAM (1Kw)

0x080000 0x080000
FLASH (512Kw)
0x3F8000[ 550t ROM (32Kw) Execution Entry
determined by L -
Boot Code Emulation Boot Mode or !
InitBoot Stand-Alone Boot Mode H
: : f |
BROM vector (64w) l
RESET - Ox3FFFCO| *reset vector Bootloading
Routines
"""""""""""" (SCl, SPI, 12C,
------------------------ USB, CAN,
Parallel 1/0)
* reset vector = OX3FEAC2 for CPU1; 0x3FE649 for CPU2
Interrupt Sources
Interrupt Sources
Internal Sources
TINT2
TINT1 EX CORE
TINTO XRS
ePWM, eCAP, eQEP, ol bl
ADC, SClI, SPI, 12C, Pafiha INT1
eCAN, McBSP, Imeﬁ’rupt INT2
LA G A D Expansion) a INT3
External Sources ’
77777777777 INT12
XINT1 — XINTS —i— INTL3
- | INT14
TZx —
|
XRS 3
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Maskable Interrupt Processing

Conceptual Core Overview

Core (IFR) (IER) (INTM)
Interrupt  “Latch” “Switch” “Global Switch”

INT1 [1] e

N2 —ffl——" F28x

: : : e Core
INT14 [1] -

¢ Avalid signal on a specific interrupt line causes the latch
to display a “1” in the appropriate bit

¢ If theindividual and global switches are turned “on” the
interrupt reaches the core

Core Interrupt Registers

Interrupt Flag Register (IFR) (pending = 1 / absent = 0)
15 14 13 9

11 10 8
RTOSINT [ DLOGINT| INT14 INT13 INT12 INT11 INT10 INT9
INT8 INT7 INT6 INT5 INT4 INT3 INT2 INT1
7 6 5 4 3 2 1 0
Interrupt Enable Register (IER) (enable = 1/ disable = 0)
15 14 13 12 11 10 9 8
RTOSINT [ DLOGINT| INT14 INT13 INT12 INT11 INT10 INT9
INT8 INT? INT6 INT5 INT4 INT3 INT2 INT1
7 6 5 4 3 2 1 0
Interrupt Global Mask Bit (INTM Bit 0
sT1 | INTM | (enable = 0 / disable = 1)

[*** Interrupt Enable Register ***/
extern cregister volatile unsigned int |IER;
IER |= 0x0008; /lenable INT4 in IER
IER &= OXFFF7; /ldisable INT4 in IER
[*** Global Interrupts ***/
asm(“ CLRC INTM"); //enable global interrupts
asm(* SETC INTM");  //disable global interrupts
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Peripheral Interrupt Expansion — PIE

Peripheral Interrupt Expansion - PIE

Interrupt Group 1
PIEIFR1 PIEIER1
INT1.y interrupt group INT1.1 /—

INT2.y interrupt group INT12 —[0}—— -

PIE module for 192 Interrupts

192

INT3.y interrupt group

. INT1
INT4.y interrupt group o .
INTS5.y interrupt group INTL.16 . ya

INT6.y interrupt group
INT7.y interrupt group

192

Core Interrupt logic

INT8.y interrupt group

INT9.y interrupt group INT1—INT12
E E E 28x
=||=| |Z| |Core

| Peripheral Interrupts 12 x 16

INT12.y interrupt group

INT10.y interrupt group | | 1, Interrupts
INT11.y interrupt group

INT13 (TINT1)
INT14 (TINT2)
NMI

F2837xD PIE Assignment Table
F2837xD PIE Assignment Table - Lower

INTx.8 INTx.7 INTx.6 | INTx.5 | INTx.4 | INTx.3 INTx.2 | INTx.1

INT1 WAKE TINTO ADCD1 XINT2 XINT1 ADCC1 ADCB1 ADCA1

INT2 PWM8_ | PWM7_ | PWM6_ | PWM5_ | PWM4_ | PWM3_ | PWM2_ | PWM1_
TZ TZ TZ TZ TZ TZ TZ TZ

INT3 PWM8 PWM7 PWM6 PWM5 PWM4 PWM3 PWM2 PWM1

INT4 ECAP6 | ECAP5 | ECAP4 | ECAP3 | ECAP2 | ECAP1
INT5 EQEP3 | EQEP2 | EQEP1
INT6 MBC_'?riP MB(i?&P MAC_@&P MAC_?&P SPIB_TX | SPIB_RX | SPIA_TX | SPIA_RX
INT7 DMA_CH6| DMA_CH5| DMA_CH4 | DMA_CH3 | DMA_CH2| DMA_CH1
INT8 | SCID_TX | SCID_RX | SCIC_TX | SCIC_RX | '2CB- 12cB 12CA 12cA

INT9 |DCANB_2|DCANB_1 | DCANA_2| DCANA_1| SCIB_TX | SCIB_RX | SCIA_TX | SCIA_RX

ADCB ADCA
INT10 ADCB4 ADCB3 ADCB2 EVT ADCA4 ADCA3 ADCA2 EVT

INT11 | CLA1.8 | CLA17 | CLA1 6 | CLAL5 | CLA1 4 | CLAL 3 | CLAL 2 | CLA1 1

INT12 FPU_UF | FPU_OF VCU XINTS XINT4 XINT3
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F2837xD PIE Assignment Table - Upper

INTX.16 | INTX.15 [ INTx.14 | INTx.13 [ INTx.12 | INTx.11 [ INTx.10 [ INTx.9
INTL IPC3 IPC2 IPC1 IPCO
Py PWMI2_ | PWMIT_ | PWNI0_ | PWMS_
INT3 EPWM12 | EPWM1L | EPWM10 | EPWM9
INT4
INTS sp2 sp1
INT6 SPIC_TX | SPIC_RX
INT7
INTS UPPA
INT9 USBA
INTL0 | ADcD4 | ADcD3 | Apcpz | ABCP- | apcca | Apccs | abccz | ARCC-
INT11
NTi2 | con or | cinor | PV | SYSEIT (R ACE| Fs c [ B e | Ve

PIE Registers
PIEIFRx register (x =1t0 12)
15 14 13 12 11 10 9 8 7 6 5 4 3 2 1 0

|INTX.16|INTX.15|INTX.14|INTX.13|INTX.12|INTX.11|INTX.10| INTX.9 | INTX.8 | INTX.7 | INTX.6| INTX.5 | INTx.4 | INTX.3 | INTX.2 | INTx.1 |

PIEIERx register (x =1to 12)
15 14 13 12 11 10 9 8 7 6 5 4 3 2 1 0

|INTx.16 INTx.15|INTx.14[INTx.13 INTx.12|INTx.11 INTx.lO| INTX.9 | INTx.8 | INTX.7 | INTX.6 | INTX.5 | INTx.4 | INTX.3 | INTx.2 | INTx.1
PIE Interrupt Acknowledge Register (PIEACK)

15-12 110 9 8 7 6 5 4 3 2 1 0
| reserved | PIEACKX |
PIECTRL register 15-1 0
| PIEVECT |ENPIE|

#include “F2837x_Device.h”
PieCtrIRegs.PIEIFR1.bit.INTx4 = 1; //manually set IFR for XINT1 in PIE group 1
PieCtrIRegs.PIEIER3.bit.INTx2 = 1; //enable PWM2 interrupt in PIE group 3
PieCtrIRegs.PIEACK.all = 0x0004;  //acknowledge the PIE group 3
PieCtrIRegs.PIECTRL.bit.ENPIE = 1; //enable the PIE
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PIE Block Initialization

PIE Block Initialization

Main.c Memory Map
// CPU Initialization @
InitPiectri();
b PIE RAM
R Vectors
) ) " 512w .
PieVect.c PieCtrl.c | (ENPIE = 1)
PIE_VECT_TABLE // Initialize PIE_RAM @
// Base Vectors @ S
9 » memcpy(eee);
> S Boot ROM
// Core INT1 re-ma -
- P // Enable PIE Block Reset Vector
b PieCtriRegs. !
// Core INT12 re-map PIECTRL.DIT. seeefeesscenncmmsssennnessessannnnnnnaal

PIE Initialization Code Flow - Summary

RESET Reset Vector Boot option determines
<Ox3F FFC0> <reset vector> = Boot Code | Code execution entry point

| CodeStartBranch.asm
l l .sect *“codestart”
MOSARAM Entry Point OR Flash Entry Point
<0x00 0000> = LB _c_int00 <0x08 0000> = LB _c_int00

I I
* ts2800_fpu32.lib
_c_inl.:OO: s _Ipuszib

CALL main(Q) v
PIE Vector Table

Main.c { Initialization() » 512 Word RAM
_ 0x00 0D00 — OEFF
main() Load PIE Vectors :
{ initialization(Q); | Enable the PIE H Defaultlsr.c
o > Enable PIEIER = = =
- nterrupt void name(void
: Enable Core IER ! upt voi (void)
¥ Enable INTM { .
3 :
b
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Interrupt Signal Flow — Summary

Peripheral Interrupt Expansion (PIE) — Interrupt Group x
PIEIFRX PIEIERX

Peripheral INTx.y 1 )\
Interrupt L= v

PieCtrIRegs.PIEIERX.bit.INTxy = 1;

Core Interrupt Logic

Core IFR IER INTM
INTX A e\
L= v v
IER |= 0x0001;  asm(“ CLRC INTM");
- OXOFFF;
PIE Vector Table Defaultlsr.c

I
l
i
1
l
!
1
I
I
¥
i
y

interrupt void name(void)

{

l

i)

}

(For peripheral interrupts where x =1 to 12, and y = 1 to 16)

INTX.y = name

F2837xD Dual-Core Interrupt Structure

F2837xD Dual-Core Interrupt Structure

Internal Sources

TINT2.1
TINTL.1 CPU1 CORE
TINTO.1 DMAL1.1 CLAL.1 NMI
INT1
ePWM, eCAP, eQEP, INT2
ADC, SCI, SPI, I12C, INT3
eCAN, McBSP, WD .
ePIE.1 .
External Sources INT12
777777777777 | INT13
XINT1 — XINT5} INT14
|

TZx ——— XRS —

CPU2 CORE
NMI
INT1
INT2
INT3

Internal Sources IN:|'12
TINTO.2 DMA1.2 CLA1.2 INT13
TINT1.2 INT14
TINT2.2

ePIE.2
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F28x7x Oscillator / PLL Clock Module
F28x7x Oscillator / PLL Clock Module

Internal | psc1cLK
0SC 1 WDCLK
(10 MHz) OSCCLKSRCSEL
Internal | osc2cLK 1x SYSCLKDIV
0sC 9 00 s OSCCLK > i
(10 MHz) y (PLL bypass) 9 '
:23 — 1/n —> PLLSYSCLK
XCLKIN
----- Q PLLCLK
X2 n. (%)
eene) O | EXTCLK PLL L
= - I ~--SYSPLLCTL1
< XCLKOUTSEL +--SYSPLLMULT
: XCLKOUTDIV
0~ Ly
101 1
AUXPLLCLK ——{101 '
CPU2.SYSCLK ——011 1/n XCLKOUT
CPU1.SYSCLK —{010
PLLCLK —|001 (GPIO 73)
PLLSYSCLK —»| W
AUXOSCCLKSRCSEL
' AUXPLLDIV
00* AUX '
D AUXCLK | 1/n AUXPLLCLK
AUXCLKIN (from GPIO) y PLL
* default
CIkCfgRegs.SYSCLKDIVSEL.bit.PLLSYSCLKDIV
OSCCLK o :
(PLL bypass) 52 H
g - 1/n |-PELSYSCLK L cpux T CPUX.SYSCLK
PLLCLK CPUxX.LSPCLK
PLL 1// LOSPCP X

- CIkCfgRegs.SYSPLLCTL1.bit.PLLCLKEN E

__[ ClkCfgRegs.SYSPLLMULT.bit.IMULT CIkCfgRegs.LOSPCP.bit. LSPCLK
ClkCfgRegs.SYSPLLMULT.bit. FMULT

IMULT CLKIN SYSPLL LSPCLK | Peripheral Clk Freq
0000000|OSCCLK /n * (PLL bypass) DIVSEL | n 8 8 2 gﬁﬂxgiggtﬁ ;;
0000001|OSCCLKx1/n 111111 /126 010 CPU?SYSCLK 14+
0000010|OSCCLK x2/n ces ces 01s | Crurovecix o
0000011|OSCCLK x3/n 000010 | /a* X.

coe cee 100 | CPUX.SYSCLK /8
1111101|0OSCCLK x 125/ n (gl | /2 101 | CPUX.SYSCLK /10
1111110|0OSCCLK x 126 /n 000000 | /1 110 | CPUX.SYSCLK /12
1111111|0SCCLK x 127 /n 111 | CPUX.SYSCLK /14
EMULT CLKIN LSBs in reg. — others reserved

00 Fractional x 0 *

01 Fractional x 0.25

10 Fractional x 0.5

11 Fractional x 0.75

* default
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F2837xD Dual-Core System Clock

CPU2 LSPCLKDIV
_l CPU2.SYSCLK ,E'P?l CPU2.LSPCLK
PLLSYSCLK CPUL1.SYSCLK ,_‘_| CPU1.LSPCLK
LOSPCP
cPU1 ] ]
5 PERX.SYSCLK PERX. SYSCL
per ---{ CPUSELY |- |/1 /2| |PERX |SCIX | |SPIX |
PERCLKDIVSEL ' EPWMCLK
EPWM
EPWMCI_KDIV ------ CPU2.TMR2CLKCTL

CPU2.SYSCLK N
INTOSCI1

INTOSC2

EXTCLK CPUTIMER2.2
WDCLK AUXPLLCLK
CPUL.SYSCLK

INTOSC1 CPUTIMER2.1
PERX-E‘;(?E::E CANx Bit CLK ”‘&gg‘ii

AUXCLKIN AUXPLLCLK | ¢
eeee- CPUL.TMR2CLKCTL

'---- CANXBCLKSEL

Watchdog Timer Module

Watchdog Timer Module

WDPS WDOVERRIDE
Watchdog 7
WDCLK /512
- Prescaler WDDIS
WDCNTR
8-bit Watchdog
Counter
CLR CNT
System WDRST
Output [—*
Reset WDCNTR Pulse |,
WDWCR less than WDINT
55 + AA WlndOW WDWCR
Detector | Good key IO
T
Watchdog
Reset Key
Register
WDKEY Bad WDCHK Key
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F28x7x General-Purpose Input-Output

F28x7x GPIO Grouping Overview

GPIOPortAGroup|  [GPIO Port A Muxl ]
_ | MuxlRegister |, Register L nout
© 7| (GPAGMUX1) | | (GPAMUXI) e ] MPUt |
[GPIO 0 to 15] [GPIO 0 to 15] _GPIOPortA Qual | | &
Direction Register o
(GPADIR) = D
GPIO Port A Group GPIO Port A Mux2 [GPIO 0 to 31] >
P Mux2 Register Register P >
b (GPAGMUX2) (GPAMUX2) -
5 [GPIO 16 t0 31] [GPIO 16 to 31]
= L
3 L] L]
Q_) L] L] L] L] L]
L] L]
Z _
@ GPIO Port F Group GPIO Port F Mux1
_ | MuxlRegister [, . Register PR nout
N (GPFGMUX1) [ 7| (GPFMUX1) " ] MPUL |
[GPIO 160 to 175] [GPIO 160 to 175] _GPIOPortF Qual |* 1§
Direction Register O
(GPFDIR) s
GPIO Port F Group GPIO Port F Mux2 [GPIO 160 to 191] ':'I-‘_l
| Mux2Register Register - >
b (GPFGMUX2) (GPFMUX2) "
[GPIO 176 to 191] [GPIO 176 to 191] L

F28x7x GPIO Pin

—— Peripheral 1

Block Diagram

GPxSET 0=Input U
GPXCLEAR 1=Output 0 o o Peripheral 2
GPXTOGGLE GPxDIR 01 10 o Peripheral 3
: i 0.5\7 1 GPXGMUXL/2
Qut |\\ |
GPxDAT In |§| —— Peripheral 5
AN 4 [ Peripheral 6
P X 01 10 ¢ Peripheral 7 00
+ To Input X-Bar i«=—— 0.6\$ 11
fffffffffffff r'.Ol
B Input I L o010 ]
NN put ———— Peripheral 9
>0 . Qualification . e Peripheral 10 °ll
GPxiNy | [GPXQSELL2 01 10 o Peripheral 11
X GPXCTRL o‘o'\T 11
1
—— Peripheral 13
12 o o Peripheral 14
01 10 o i
—’\/\/v—llnternaIPuII-Up 0‘5\7 o Peripheral 15
GPxPUD) 3G —
i (default GPIO 0-xx) GPXMUX1/2

See device datasheet for pin function selection matrices
Logic shown is functional representation, not actual implementation

,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,

*=Default x=A,B,C,D,E,orF

1
]
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Reset, Interrupts and System Initialization

F28x7x GPIO Input Qualification
Nl

Input to GPIO and
pin O o peripheral
Qualification modules

1
CPUX.SYSCLK

¢ Qualification available on ports A - F

¢ Individually selectable per pin
¢ no qualification (peripherals only)
¢ sync to CPUX.SYSCLK only
¢ qualify 3 samples
¢ qualify 6 samples

samples taken

Vodod

T T T

T =qual period

GPIO Input X-Bar

F28x7x GPIO Input X-Bar

—— InpuT7 — eCAPL
—— INPUT8 —> eCAP2

GPIO0 —— Asynchronous
e | Synchronous Input X-Bar INPUTO —| eCAP3
GPIOx — | Sync. + Qual. —— INPUT10 —» eCAP4
- INPUT11 —»{ eCAP5

— INPUT12 —>| eCAP6

I I
< ™
OO T MONA
EFEEEEEEE
220220222222
[ o e o e
Z2zzzzzzz
XINTS TZ1, TRIP1 —|
CPU.PIE —1 XINT4 T22,TRIP2 =
XINT3 TZ3, TRIP3 —»
CLA L I XiNT2 —— TRIP4 —
— XINTL [ TRIPS /¥
S ——TrRIP7 —— €PWM
e I
TRIPE = Modules
X-Bar [—— TRIP9 —»
—— TRIP10 —»
—— TRIP1L —>
—— TRIP12 —>
TRIPG

ADC ADCEXTSOC

EXTSYNCINI — ePWM and eCAP
EXTSYNCIN2 —>| Sync Chain

Output X-Bar
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Reset, Interrupts and System Initialization

This block diagram is replicated 14 times

GPIO 0 @&——

.
L]
L

GPIO N .—b/

L]
Ld
Ld

INPUTX

INPUTXSELECT

F28x7x GPIO Input X-Bar Architecture

Input Destinations

INPUT1 ePWM[TZ1, TRIP1], ePWM X-Bar, Output X-Bar

INPUT2 ePWM[TZ2, TRIP2], ePWM X-Bar, Output X-Bar

INPUT3 ePWM[TZ3, TRIP3], ePWM X-Bar, Output X-Bar

INPUT4 XINT1, ePWM X-Bar, Output X-Bar

INPUTS XINT2, ADCEXTSOC, EXTSYNCIN1, ePWM X-Bar, Output X-Bar
INPUT6 XINT3, ePWM[TRIP6], EXTSYNCIN2, ePWM X-Bar, Output X-Bar
INPUT7 eCAP1

INPUT8 eCAP2

INPUT9 eCAP3

INPUT10 eCAP4

INPUT11 eCAP5

INPUT12 eCAP6

INPUT13 XINT4

INPUT14 XINTS

GPIO Qutput X-Bar

L CTRIPOUTH
CMPSS1 L cTRIPOUTL
(]
L]
L]
L CTRIPOUTH
CMPSS8 L CTRIPOUTL

| EPWM/ECAP sync |— extswcour —»

| ADCSOCAO  |— socsoca
| ADCSOCBO  |— #pcsocs
ADCA — EVT1toEVT4
ADCB — EVT1toEVT4
ADCC — EVT1toEVT4
ADCD — EVT1toEVT4
ECAP1 — EcapLOUT
ECAP2 — Ecap20uUT
ECAP3 — EcAP3.OUT
ECAP4 —— Ecapa.oUT
ECAP5 —— ECAP5.0UT
ECAP6 | — ECAP6.0UT

2187

LU ]

OUTPUT
X-Bar

OUTPUTL
OUTPUT2
OUTPUT3
OUTPUT4
OUTPUTS
OUTPUT6
OUTPUT7
OUTPUT8

INPUTL

F28x7x GPIO Qutput X-Bar

— GPIO
~ Module

INPUT2

INPUT3
INPUT4

INPUT X-Bar

INPUTS

INPUTE

allalla

A

FLT1.COMPH ~
FLT1.COMPL +

.
L]
L]

FLT4.COMPH
FLT4.COMPL

FLT1.COMPH -
FLT1.COMPL -|

L d
.
.

FLT4.COMPH 4
- FLT4.COMPL

SD1

SD2
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Reset, Interrupts and System Initialization

F28x7x GPIO Output X-Bar Architecture

OUTPUTXMUXENABLE

Muxed with
Peripheral

OUTPUTLATCHENABLE GPIO Pins

OUTPUTX

° {
. OUTPUTINV
%%% This block diagram is replicated 8 times
31.3
31.4 i
OUTPUTXMUX16TO31CFG.MUX31
MUX 0 T 2 3 UX 0 T 2 3
0| CMPSSLCTRIPOUTH | CMPSSLCTRIPH_OR_CTRIPL | ADCAEVTL | ECAPLOUT 16| SDIFLTLCOMPH | SDIFLTLCOMPH_OR COMPL
T_| CMPSSLCTRIPOUTL INPUTXBARL ADCCEVTL 17| SDIFLTLCOMPL
2| CMPSS2.CTRIPOUTH | CMPSSZCTRIPH_OR_CTRIPL | ADCAEVT2 | ECAPZOUT 18| SDIFLT2COMPH | SDIFLTZCOMPH_OR_COMPL
3| CMPSS2CTRIPOUTL INPUTXBARZ ADCCEVTZ 19 | SDIFLT2COMPL
4 CMPSS3.CTRIPOUTH | CMPSS3.CTRIPH_OR_CTRIPL | ADCAEVT3 ECAP3.0UT 20 SD1FLT3.COMPH SDIFLT3.COMPH_OR_COMPL
5 CMPSS3.CTRIPOUTL INPUTXBAR3 ADCCEVT3 21 SD1FLT3.COMPL
6| CMPSSA.CTRIPOUTH | CMPSS4.CTRIPH_OR CTRIPL | ADCAEVT4 | ECAP4.0UT 22| SDIFLT4COMPH | SDIFLT4.COMPH_OR COMPL
7| CMPSS4CTRIPOUTL INPUTXBAR® ADCCEVT4 23| SDIFLTACOMPL
8 | CMPSS5.CTRIPOUTH | CMPSS5.CTRIPH_OR_CTRIPL | ADCBEVTL | ECAP5.0UT 2 | SD2FLTLCOMPH | SD2FLTLCOMPH_OR COMPL
9| CMPSS5.CTRIPOUTL INPUTXBARS ADCDEVTL %5 | SDZFLTLCOMPL
10_| CMPSS6.CTRIPOUTH | CMPSS6.CTRIPH_OR_CTRIPL | ADCBEVTZ | ECAP6.0UT % | SD2FLTZCOMPH__| SD2FLTZCOMPH_OR_COMPL
11| CMPSSG.CTRIPOUTL INPUTXBARG ADCDEVT2 21| SD2FLT2COMPL
12 CMPSS7.CTRIPOUTH | CMPSS7.CTRIPH_OR_CTRIPL | ADCBEVT3 28 SD2FLT3.COMPH SD2FLT3.COMPH_OR_COMPL
13_| CMPSST.CTRIPOUTL ADCSOCA ADCDEVT3 29| SD2FLT3COMPL
14| CMPSSBCTRIPOUTH | CMPSSB.CTRIPH_OR CTRIPL | ADCBEVT4 | EXTSYNCOUT | 30 SD2FLT4.COMPH | SD2FLT4.COMPH_OR_COMPL
15_| CMPSSBCTRIPOUTL ADCSOCB ADCDEVT4 3L | SD2FLTACOMPL
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Analog Subsystem

Analog Subsystem

Analog Subsystem
¢ Four dual-mode ADCs

¢ 16-bit mode
¢ 1 MSPS each (up to 4 MSPS system)
¢ Differential inputs
¢ External reference
¢ 12-bit mode
¢ 3.5 MSPS each (up to 14 MSPS system)
¢ Single-ended or differential inputs
¢ Internal or external reference

¢ Eight comparator subsystems

¢ Each contains:
¢ Two 12-bit reference DACs
¢ Two comparators
< Digital glitch filter

¢ Three 12-bit buffered DAC outputs
¢ Sigma-Delta Filter Module (SDFM)

ADC Subsystem

VREFAO—l VREFCO—l

DACOUTA/ADCINAO 0 0
DACOUTB/ADCINAL 1 Reserved 1
CMPINIP/ADCINA2 2 Cl DCINC2 2
CMPININ/ADCINA3 3 Cl DCINC3 3
CMPIN2P/ADCINA4 4 [of DCINC4 4
CMPIN2N/ADCINAS 5 Cl DCINCS 5

Reserved 6 | apca 5| abpcc
Reserved 7 b 7

VREFLOA 8 16/12-bit VREFLOC 8 16/12-bit

VREFLOA 9 16 channel VREFLOC 9 16 channel
Reserved 10 10
Reserved 11 11
DACOUTA 12 DACOUTA 12
TEMP SENSOR 13 13
CMPIN4P/ADCIN14 ig 1‘5‘

CMPIN4N/ADCIN15
VREFB.—l VREFD.—l

VDAC/ADCINBO 0 CMPIN7P/ADCINDO 0
DACOUTC/ADCINB1 1 CMPIN7N/ADCIND1 1
CMPIN3P/ADCINB2 2 CMPINSP/ADCIND2 2
CMPIN3N/ADCINB3 3 Cl DCIND3 3
ADCINB4 4 ADCIND4 4
ADCINBS 5 ADCINDS 5
Reserved 6 Reserved 6

Reserved 7 ADC'B Reserved 7 ADC'D

VREFLOB 8 16/12-bit VREFLOD 8 16/12-bit

VREFLOB 9 16 channel VREFLOD 9 16 channel
Reserved 10 Reserved 10
Reserved 11 Reserved 11
DACOUTA 12 DACOUTA 12
Reserved 13 Reserved 13
14 14
15 15

*** Multiple ADC modules allow simultaneous sampling or independent operation ***
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Analog Subsystem

ADC Module Block Diagram

ADC Module Block Diagram

X
(&)
ADCINO—> [ADCRESULTO |@
ADGIN —] ADCRESULTO @
ADCIN2 —>| TEET ADCRESULT1 k=
H 1))
ADC.ZIN3—> MUX A ADCRESULT2 §
. Converter o
ADCIN14—> SOCx %
ADCIN15—> S
ADC full-scale —
input range is CHSEL cerdC. |EOCx | Int’gﬁﬁpt ADCINT1-4_
0to3.3V Logic Logic
SOCx Signal ADCINT1
ADCINT2
SOCO [TRIGSEL [CHSEL [ACQPS
SOC1 |TRIGSEL |CHSEL |[ACQPS | @
SOC2 [TRIGSEL |CHSEL [ACQPS | &, Software
SOC3 |[TRIGSEL |CHSEL |ACQPS |-2 CPU1 Timer (.12
e EPWMXSOCA/C x=1t12)
5 5 5 Qe EPWMxSOCB/D (x=1112)
) External Pin(prio/apcexTsoc)
SOC15 |[TRIGSEL [CHSEL [ACOQPS CPU2 Timer (1.2

SOCx Configuration Registers

ADC SOCx Functional Diagram

ADCSOCFRC1

Software Trigger

TINTO (CPU1 Timer 0)—
TINT1 (CPU1 Timer 1) —
TINT2 (CPU1 Timer 2)—
ADCEXTSOC (GPIO) —»|
SOCAIC (ePWM1) —|
SOCB/D (ePWM1)—

o L] —>
L]

L]
SOCA/C (ePWM12)—»
SOCB/D (ePWM12) —»
TINTO (CPU2 Timer 0)—
TINT1 (CPU2 Timer 1)—»
TINT2 (CPU2 Timer 2)—»

Re-Trigger

—nQQ — =~ o

ADCINTL | >——

ADCINT2 | >————-

ADCSOCXCTL
ADCRESULTx
ADCINT1
Channel Sample Result ADCINT2
S Select Window Register| E ADCINT3
] 0 0 ADCINT4
C C
X X
ADCINTSOCSEL1 INTSELxNy

This block diagram is replicated 16 times

ADCINTSOCSEL?2
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Analog Subsystem

ADC Triggering
Example — ADC Triggering

Sample AO A2 > A5 when ePWM1 SOCB/D is generated and then generate ADCINTL1:

SOCB/D (ETPWML) o= Ch%%nel ?g%ﬁ’gg Result0 no interrupt
SOC1 | Channel Sample _

A2 10 cy(F:)Ies Resultl no interrupt
SOC2 [ Channel Sample

A5 8 cycles Result2 ADCINT1

Sample A2 2> A4 = A6 continuously and generate ADCINT2:

Software Trigger

SOC3 | Channel Sample i
A2 10 cycles Result3 no interrupt
SOc4 :
ADCINT2 Chﬂnel lgagggllees Result4 no interrupt
SOCS5 | Channel Sample
A6 12 cycles Results ADCINT2

Note: setting ADCINT2 flag does not need to generate an interrupt

Example — ADC Ping-Pong Triggering

| Sample all channels continuously and provide Ping-Pong interrupts to CPU/system: |

Softwarzl;l'glgl\?:zr $ SOCO Ch%r(l)nel ???C?Iei no interrupt
soc1 chgnlnel ?g;rclfelg nointerrupt
soc2 Chggnel 7Sg;/ncil)elzes! ADCINTl
Smtwari;!ﬁ?:;@ socs3 Chg%nel 78331(:[')}32 no interrupt
SOC4 Chgr;rnel 732)%%(; no interrupt
Sele Chgnsnel 7Sg)r;r1clil>|ees ADC|NT2
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Analog Subsystem

ADC Conversion Priority

ADC Conversion Priority

¢ When multiple SOC flags are set at the same time —
priority determines the order in which they are converted

¢ Round Robin Priority (default)
+ No SOC has an inherent higher priority than another
+ Priority depends on the round robin pointer

¢ High Priority

« High priority SOC will interrupt the round robin wheel
after current conversion completes and insert itself as
the next conversion

« After its conversion completes, the round robin wheel
will continue where it was interrupted

¢ Round Robin Burst Mode

+ Allows a single trigger to convert one or more SOCs in
the round robin wheel

+ Uses BURSTTRIG instead of TRIGSEL for all round
robin SOCs (not high priority)

Conversion Priority Functional Diagram

SOCO

>
% SOC1 SOC Priority
< [soc2 Determines cutoff point
= SOC3 for high pri_ority and
.‘f” SOCa round robin mode
T Socs SOCPRIORITY
SOC6 AdcRegs. SOCPRICTL
SOC7

= SOC8 RRPOINTER
8 SOC9 _ _
.c< SOC10 R_ound Robin Pointer
c SOC11 Points to the last converted
> .
E% SOC12 round rob!n SOCx and
SOC13 determines order
SOC14 of conversions
\_| SOC15
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Analog Subsystem

Round Robin Burst Mode Diagram

AdcxRegs. ADCBURSTCTL e e
BURSTEN I.f Disables/enables burst mode

BURSTSIZE

SOC Burst Size
Determines how many

BURSTTRIGSEL SOCs are converted per
burst trigger

Software, CPU1 Timer0-2

ePWM1 ADCSOCA/C — B/D >
ePWM12 ADCSOCA/C — B/D

CPU2 Timer0-2

SOC Burst Trigger
Source Select
Determines which trigger
starts a burst conversion
sequence

Post Processing Block

Purpose of the Post Processing Block

¢ Offset Correction

¢ Remove an offset associated with an ADCIN channel possibly
caused by external sensors and signal sources

¢ Zero-overhead; saving cycles
¢ Error from Setpoint Calculation

# Subtract out a reference value which can be used to automatically
calculate an error from a set-point or expected value

¢ Reduces the sample to output latency and software overhead
¢ Limit and Zero-Crossing Detection

¢ Automatically perform a check against a high/low limit or zero-
crossing and can generate atrip to the ePWM and/or an interrupt

+ Decreases the sample to ePWM latency and reduces software overhead;
trip the ePWM based on an out of range ADC conversion without CPU
intervention

¢ Trigger-to-Sample Delay Capture

¢ Capable of recording the delay between when the SOC is
triggered and when it begins to be sampled

+ Allows software techniques to reduce the delay error
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Analog Subsystem

Post Processing Block - Diagram

Delay Capture

ADCEVTSEL.PPBXTRIPLO

SOC Control Signals

SoC
Trigger
Detect

SocC

ADCEVTSEL.PPBXTRIPHI

Start

Detect

latcl

ADCEVTSEL.PPBXZERO

latcl

ADCEVTSTAT.PPBXTRIPLO

[REQsTAMPX DLYSTAMPx|
FREECOUNT f

ADCEVTSTAT.PPBXTRIPHI

Offset Correction

ADCPPBXOFFCAL| '/ Saturation
ADC Output \, saturate
+ ADCRESULTy

ADCEVTSTAT.PPBXZERO

Threshold Compare

Zero
Crossing

Detect

Error/Bipolar Calculation

ADCPPBXOFFREF

+ [ Twos
>(Z Comp ADCPPBXRESULT
Inv.

Enable

[ ADCPPBXCONFIG TWOSCOMPEN |

=

{: EVENTX

H—

INTX

ADCPPBXTRIPHI ):'+:

j‘+ :
ADCPPBXTRIPLO H-

ADCEVTINTSEL.PPBXZERO

ADCEVTINTSEL.PPBXTRIPHI

ADCEVTINTSEL.PPBXTRIPLO

=

J—L/

Blocks

Post Processing Block 1

EVENTxX

Post Processing Block Interrupt Event

¢ Each ADC module contains four (4) Post Processing

¢ Each Post Processing Block and be associated with
any of the 16 ADCRESULTX registers

ADCEVT1

INTX

Post Processing Block 2

EVENTX

ADCEVT2

Post Processing Block 3

EVENTxX

INTX |
—\$ ADCEVTINT

ADCEVT3

INTX

Post Processing Block 4

EVENTxX
INTX

ADCEVT4
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Analog Subsystem

Comparator Subsystem

Comparator Subsystem

¢ Eight Comparator
Subsystems (CMPSS)

L 2 EaCh CMPSS haS: CMPIN1P/ADCINA2

CMPININ/ADCINA3 :'2’{

& Two analog comparators  cupiowaocnas & ADCA
. CMPIN4P/ADCIN14 14
¢ Two programmable 12-bit  cvPinavadciNis 15

DACS CMPIN3P/ADCINB2 -
B3 aocs
+ Two digital filters CHPINGNABCINGS
¢ Ramp generator SME.'RSE?QBSIN%%% ADCC
# Digital filter used to CUPIRSNADONGS 5
remove spurious trip CMPINTPIADCINDO 0
signals (majority vote) gm;ﬁ;ﬁgg:ggg%; APEP
CMPIN8N/ADCIND3 &
¢ Ramp generator used
peak current mode control

¢ Ability to synchronize
with PWMSYNC event

Comparator Subsystem Block Diagram

CMPINXP
[ CTRIPH
Digital
DACH | Filter
VALS DACH i '
: PWM
VALA T | CTRIPOUTH | €
NN DAC ! COMPHINV Event
: Trigger
DACSOURCE &
CTRIPL SO
MUX
CMPINXN
[ - Digital
Filter
DACL | | DACL
VALS [I| VALA COMPLINY  CTRIPOUTL
COMPLSOURCE
DAC Reference Comparator Truth Table
Vi _ DACxVALA * DACREF Voltages Output
DAGK™ 4096 Voltage A < Voltage B 0
Voltage A > Voltage B 1
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Analog Subsystem

Digital-to-Analog Converter

Digital-to-Analog Converter

_ P e—
& Three buffered 12-bit DACs ADC-A

DACOUTA @———p| 12

mo

¢ Provides a programmable
reference output voltage oAcoUTCrADCINE > 1

ADC-B
DACOUTA @——————————Pp 12

¢ Capable of driving an
external load

ADC-C

+ Ability to be synchronized pACOUTA e pf12
with PWMSYNC events

¢ Selectable reference voltage ADCD

DACOUTA @———————Pp 12

Buffered DAC Block Diagram

DACREFSEL
VDAC
VREFHI

DACV [ | DACV | 12-bit Vpacour
ALS ALA DAC

VSSA
VREFLO

Vooa DACOUTEN

N

DACREFSEL
Ideal Output
* VREFHIA can supply reference
Vineau = DAGHALN TIDACINS for DAC A and DAC B; VREFHIB
4096 can supply reference for DAC C
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Analog Subsystem

Sigma Delta Filter Module (SDFM)
Sigma Delta Filter Module (SDFM)

¢ SDFM is a four-channel digital filter designed
specifically for current measurement and resolver
position decoding in motor control applications

¢ Each channel can receive an independent modulator
bit stream

¢ Bit streams are processed by four individually
programmable digital decimation filters

¢ Filters include a fast comparator for immediate
digital threshold comparisons for over-current
monitoring

¢ Filter-bypass mode available to enable data logging,
analysis, and customized filtering

SDFM Block Diagram

PWM
CMPC/D

SDFILRESN SDFM- Sigma Delta Filter Module
A e Filter Module 1
Streams Direct [
SDINT
Comparator | Interrupt PIE
INL b
Filter Unit
CcLK1 "(‘:‘ﬁ‘ —
;;;;;;
Sinc Filter — =
——————
g\:_sz Filter Module 2
— N
N3 e & s V| Register VBUS32
CLK3 Filter Module 3 Map
——————Go
::NLL Filter Module 4

56 C2000 MCU 1-Day Workshop



Lab 2: Analog-to-Digital Converter

Lab 2: Analog-to-Digital Converter
» Objective

The objective of this lab exercise is to demonstrate and become familiar with the operation of the
on-chip analog-to-digital converter. In this lab exercise all the code will run on CPU1 (CPU2 will
not be used). The ADC will be configured to sample a single input channel at a 50 kHz sampling
rate. We will use ePWM2A to automatically trigger the SOCA signal at the desired sampling rate
(ePWM period match CTR=PRD SOC). The ADC end-of-conversion interrupt will be used to
prompt CPU1 to copy the results of the ADC conversion into a circular memory buffer
(AdcaResults).

In order to generate an interesting input signal, the code also alternately toggles a GPIO pin high
and low in the ADC interrupt service routine. This pin will be connected to the ADC input pin by
means of a jumper wire. Using Code Composer Studio the sampled data will be viewed in
memory and displayed with the graphing feature. We will then configure one of the internal DACs
to generate a fixed frequency sine wave with programmable offset and measure this signal in the

same way.
Lab 2: Analog-to-Digital Converter
Toggle
(GPIO18) DACB
) data
ADC _ memory
connector CPU copies result
: to buffer during
wire RESULTO ADC ISR 'g
H
o
ADCINAO t
. 7]
? : E
i ePWM2 triggering " 8.
i ADC on period match
i using SOCA trigger every E'
' View ADC
| 20us (S0 k) g
* Samples
Code Composer
Studio
ePWM2

> Procedure

Open the Project

1. Aproject named Lab2_cpuO1 has been created for this lab. Open the project by clicking on
Project - Import CCS Projects. The “Import CCS Eclipse Projects” window will
open then click Browse... next to the “Select search-directory” box. Navigate to:
C:\F2837xD\Labs\Lab2\cpu01 and click OK. Then click Finish to import the project.
All build options have been configured the same as the previous lab.

Click on the project name in the Project Explorer window to set the project active. Then click
on the plus sign (+) to the left of Lab2_cpu01 to expand the file list.
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Lab 2: Analog-to-Digital Converter

Inspect the Project

2.

Open and inspect Lab2_cpu01.c. The initialization code immediately following main() is
similar to that used in lab 1. Notice the inclusion of the following four functions which set up
the ADC, PWM and DAC. The last function configures the ADC to be triggered by an EPWM
event and to generate a CPU interrupt.

ConfigureADC(Q)
ConfigureEPWMQ
ConfigureDAC(Q)
SetupADCEpwm()

The code for these functions is located further down in the same file.

At the bottom of the file is the Interrupt Service Routine (ISR) adcal_isr. This is triggered
by an end-of-conversion event from ADC-A. The ISR code reads and stores the newest ADC
result in the buffer AdcaResults. The variable resultslndex keeps track of the last entry
in the buffer and wraps around to the first entry when the end of the buffer is reached. This
implements a circular buffer to store a continuous stream of incoming ADC data.

151 interrupt void adcal_isr(void)

152 {

153 '/ Read the ADC result and store in circular buffer

154 AdcaResults[resultsIndex++] = AdcaResultRegs.ADCRESULTE;
155 if{RESULTS BUFFER SIZE <= resultsIndex)

156 7

157 resultsIndex = @;

158 }

Also, the ISR contains code to toggle the GP1018 pin which be measured with the ADC. This
pin toggles between 0V and +3.3V every sixteen interrupts. If everything works as expected,
the AdcaResul ts buffer should contain a repeating sequence of 16 readings of close to
0x0000 followed by another 16 readings close to OxOFFF (i.e. full scale).

// Toggle GPIO18 so we can read it with the ADC
if (ToggleCount++ »>= 15)
{

]

GpioDataRegs .GPATOGGLE.bit.GPIO18 = 1;
ToggleCount = @;

b
oo OhEh O Oy

[V, SR WU

}

The last two lines in the ISR clear the interrupt flag at the ADC and acknowledge the PIE
level group interrupt so that the next ADC EOC event will trigger an interrupt.

173 / Return from interrupt
179 AdcaRegs . ADCINTFLGCLR.bit.ADCINTL = 1; J// Clear ADC INT1 flag
158 PieCtrlRegs.PIEACK.all = PIEACK GROUPL; /! Acknowledge PIE group 1

Jumper Wire Connection

In order to have a meaningful input signal to the ADC, a jumper wire will connect the ADC input
pin to the GP1018 pin. This pin has been set up in the ADC ISR to alternately toggle between 0V
and +3.3V.

4. On the LaunchPad locate connector J3, pin #30 (ADCINAQ). Connect one end of the jumper

wire to this pin, and the other end of the jumper wire to the adjacent connector J1, pin #4
(GPI1018). Refer to the following diagram for the pins that need to be connected using the
jumper wire.

58
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Lab 2: Analog-to-Digital Converter

Build and Load the Project

5. Click the “Build” button and watch the tools run in the Console window. Check for any errors
in the Problems window.

6. Click the “Debug” button (green bug). A Launching Debug Session window will open. Select
only CPUL to load the program on, and then click OK. The “CCS Debug” perspective view
should open, the program will load automatically, and you should now be at the start of
main().

7. After CCS loaded the program in the previous step, it set the program counter (PC) to point to
_c_int00. It then ran through the C-environment initialization routine (runtime support library)
and stopped at the start of main(). CCS did not do a device reset, and as a result the
bootloader was bypassed.

In the event the device undergoes a reset, the proper boot mode needs to be set. Therefore,
we must configure the device by loading values into EMU_KEY and EMU BMODE so the
bootloader will jump to “M0 SARAM” at address 0x000000. Set the bootloader mode using
the menu bar by clicking:

Scripts > EMU Boot Mode Select -> EMU_BOOT_SARAM

If the device is power cycled between lab exercises, or within a lab exercise, be sure to re-
configure the boot mode to EMU_BOOT_SARAM.

View the ADC Results

8. Click the “Expressions” tab near the top of the CCS window. In the empty box in the
“Expression” column (click on the text “Add new expression”), type AdcaResults and then
enter. This will add the ADC results buffer to the watch window. Click on the “+” symbol to
the left of the buffer name. Notice the buffer is divided into three separate groups of 100
elements or less. Expand the first of these so we can inspect the ADC results later.

()= Variables | & Expressions 52 | i1} Registers [ | o7 5& qnﬁ“'| ) | "‘l’%& ¥ = 8
Expression | Type | Value | Address
= [S AdcaResults unsigned shaort[256] Ox0000AADDEData Ox0000AADDEData

(= [o...99]

= 100 ... 199]
(= [200... 255]
57 Add new expression
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Lab 2: Analog-to-Digital Converter

Run the Code

9. Run the code by using the “Resume” button on the toolbar, or by using Run - Resume on
the menu bar (or F8 key). LED D10 should be blinking at a period of approximately 1
second.

10. Halt the code after a few seconds by using the “Suspend” button on the toolbar, or by using
Run - Suspend on the menu bar (or Alt-F8 key).

11. Observe the contents of the AdcaResults buffer in the Expressions window. If the code is
running as expected, you should see a series of sixteen readings close to 0, followed by
another series close to full scale (4095).

View the ADC Results Buffer in Memory
12. Open a memory browser by clicking View > Memory Browser.

13. In the box marked “Enter location here”, type &AdcaResults and then enter. The memory
browser will display the contents of the ADC results buffer. The browser should contain a
series of entries of 0XOFFF and 0x0000, indicating the data is from the toggling GPIO pin.

@ Memory Browser &3 #'@'ﬁ'qﬁ@&|f‘j=¢ ¥ =8
IData j | BAdcaResults ;I

Data:0xaall - AdcaResults <Memory Rendering 1> &2

I 16-Bit Hex - TT Style ‘l

Bx@0BOAAGE AdcaResults |
BxBEEBAABE  BBBS 0DB4 BBG4 GEG4 BG4 DDOA BBOS BBE3 BEE4 BEE3 GBS 0003 0OD4 BBBA BBB4 BER2 BFFF OFFF OFFF OFFF BFFF BFFF BFFF OFFF
8xBBBBAALE OFFF OFFF OFFF OFFF OFFF OFFF BFFF OFFF 8004 0604 G006 0005 0003 POD4 BOBS BG4 GOB4 G004 00D GDDA 0DB2 00E3 BPB3 6084
@xBBOBAA3E OFFF OFFF OFFF OFFF OFFF OFFF OFFF OFFF BFFF OFFF GFFF OFFF BFFF BFFF BFFF 6FFF G002 6004 0004 0003 0DBS 0004 0B84 6084
BxBBBBAALE  BBG4 BBE3 GEO3 GBE3 GBO4 DOOL BBO4 BBB4 BFFF BFFF BFFF OFFF OFFF BFFF BFFF BFFF GFFF OFFF OFFF OFFF BFFF BFFF BFFF OFFF
BXBEBBANGE ©BOS 0PO4 B03 GBO4 OBG3 DOOA DOD1 PODL BOO4 BEG4 BOB BODA 0ODA BODA BOB3 BEB4 BFFF OFFF OFFF OFFF OFFF BFFF OFFF OFFF
8xBBBBAATS OFFF OFFF OFFF OFFF OFFF OFFF OFFF OFFF 8005 0604 G064 0003 0004 G0DS 0OD3 0004 GES G0G4 0DBA HDOA ODBS 0PB4 BBE6 BBES
8xBBBBAAIE BFFF OFFF BFFF @FFF OFFF OFFF BFFF BFFF BFFF BFFF @FFF OFFF BFFF BFFF BFFF GFFF G000 0004 0004 B0B7 BBB4 B0B4 BBB4 6084
BXxBBBBAANE  ©BO4 0PO4 BBO3 DBG3 BG4 DOOL BBA4 POBB BFEFF BFFF BFFF BFFF OFFF 8FFF BFFF OFFF OFFF GFFF OFFF OFFF OFFF BFFF OFFF OFFF
6XxBOBBAACE ODOA 0DOA BB04 GBO4 DBO3 DOOL DOO3 PODL BOO4 BOO4 BOB4 BOD4 BODA BODA BOBS 66B3 OFFF OFFF OFFF OFFF OFFF OFFF OFFF OFFF
@xBBBBAADE  BFFF OFFF BFFF @FFF OFFF OFFF GFFF BFFF BBOS 0604 G004 D005 0002 BEE2 BG4 BEG4 BEG4 G004 0OD4 BOBL BBB4 B0B4 BBES 6084
8XxBBBBAAFG OFFF OFFF BFFF OFFF @FFF OFFF BFFF 8FFF BFFF OFFF OFFF OFFF OFFF OFFF OFFF BFFF

Graph the ADC Data

CCS can display the ADC results in the form of a time graph. This provides a clear visualization
of the signal at the ADC input.

14. Open and set up a graph to plot a 256-point window of the ADC results buffer. Click:
Tools > Graph - Single Time and set the following values:

Acquisition Buffer Size 256

DSP Data Type 16-bit unsigned integer
Sampling Rate (Hz) 50000

Start Address AdcaResults

Display Data Size 256

Time Display Unit sample

Select OK to save the graph options.

The graph view should look like:
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W Single Time -0 22 BHEE -4 -8R HSEF %E ar-68E =0

4000

3000

2000

1000

0
T T T T T T T T T T T
a +25 +50 +75 +100 +125 +150 +175 +200 +225 +250

sample

Using Real-Time Emulation Mode

Real-time emulation is a special emulation feature that allows the windows within Code
Composer Studio to be updated at up to a 10 Hz rate while the MCU is running. This not only
allows graphs and watch windows to update, but also allows the user to change values in watch
or memory windows, and have those changes affect the MCU behavior. This is very useful when
tuning control law parameters on-the-fly, for example.

15. We need to enable the graph window for continuous refresh. Select the Single Time graph.
In the graph window toolbar, left-click on the yellow icon with the arrows rotating in a circle
over a pause sign. Note when you hover your mouse over the icon, it will show “Enable
Continuous Refresh”. This will allow the graph to continuously refresh in real-time while
the program is running.

16. Enable the Memory Browser and Expressions window for continuous refresh using the same
procedure as the previous step.

17. Run the code and watch the windows update in real-time mode. Click:
Scripts > Realtime Emulation Control - Run_Realtime_with_Reset

18. Carefully remove and replace the connector wire from the ADC input. Are the values
updating as expected? The ADC results should be zero when the jumper wire is removed.

19. Fully halt the CPU in real-time mode. Click:
Scripts > Realtime Emulation Control -> Full_Halt

Sampling a Sine Wave

Next, we will configure DAC-B to generate a fixed frequency sine wave. This signal will appear
on an analog output pin of the device (DACOUTB/ADCINAL). Then using the jumper wire we will
connect the DAC-B output to the ADC-A input (ADCINAOQ) and display the sine wave in a graph
window.

20. Notice the following code lines in the adcal_isr()in Lab2_cpu01l.c source file:

167 /f Write to DACBE to create input to ADC-AB
1 if (sineEnable != @)
169 {
17a dacOutput = dacOffset + (({QuadratureTable[resultsIndex ¥ @x28] ~ 8x3888) »>> 5);
171 L
172 else
173 i
1 dacOutput = dacOffset;
h

176 DacbRegs.DACVALS.all = dacOutput;

The variable dacOffset allows the user to adjust the DC output from DAC-B from an
Expressions window in CCS. The variable sineEnable is a switch which adds a fixed
frequency sine wave to the DAC offset. The sine wave is generated using a 32-point look-up
table contained in the source file sinetab.c. We will plot the sine wave in a graph window
while manually adjusting the offset.
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21. Open and inspect sinetab.c. (If needed, open the Project Explorer window in the “CCS
Debug” perspective view by clicking View = Project Explorer). The file consists of an
array of 40 signed integer points which represent five quadrants of sinusoidal data. The first
32 points are a complete cycle. In the source code we need to sequentially access each of
the first 32 points in the array, converting each one from signed 16-bit to un-signed 12-bit
format before writing it to the DACVALS register of DAC-B.

22. In the Expressions window collapse the AdcaResults buffer variable by clicking on the “-
symbol to the left of the variable name. Then add the following variables to the Expressions
window:

e sineEnable
e dacOffset

23. Remove the jumper wire from connector J1, pin #4 (GP10O18) and connect it to connector J7,
pin #70 (DACOUTB). Refer to the following diagram for the pins that need to be connected
using the jumper wire.

o e
8 g

8

A AL , &3
2t g3 8

O]

- Eq
)

24. Run the code (real-time mode) using the Script function: Scripts > Realtime
Emulation Control -> Run_Realtime_with_Reset

25. At this point the graph should be displaying a DC signal near zero. Click on the dacOffset
variable in the Expressions window and change the value to 800. This changes the DC
output of the DAC which is applied to the ADC input. The level of the graph display should
be about 800 and this should be reflected in the value shown in the memory buffer (note: 800
decimal = 0x320 hex).

26. Enable the sine generator by changing the variable sineEnable in the Expressions window
to 1.

27. You should now see sinusoidal data in the graph window.

[z Single Time -0 52 HFEF S - -Sa Q- HlePFREla-8E =0
2000
1500
1000
500
0
—— —— —
1] +25 +50 +75 +100 +125 +150 +175 +200 +225 +250
sample

28. Try removing and re-connecting the jumper wire to show this is real data is running in real-
time emulation mode. Also, you can try changing the DC offset variable to move the input
waveform to a different average value (the maximum distortion free offset is about 2000).

29. Fully halt the code (real-time mode) by using the Script function: Scripts > Realtime
Emulation Control -> Full_Halt
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Terminate Debug Session and Close Project

30. Terminate the active debug session using the “Terminate” button. This will close the
debugger and return CCS to the “CCS Edit” perspective” view.

31. Next, close the project by right-clicking on Lab2_cpu01 in the Project Explorer window and
select Close Project.

End of Exercise
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Control Peripherals

ePWM Module Signals and Connections

ePWM Module Signals and Connections

-
ePWMx-1
A
EPWMxSYNCI | EPWMXTZINT
bar > I
X-Bar v X CLA
oep -EQEPERR — 124 EPWMXA
GPIO
svecrrL .CLOCKFAIL - 175 ePWMx S e
<pyy EMUSTOP - 126
EPWMxSOCA
cPWM > EPwWMxSOcCB | ADC
X-Bar EPWMXSYNCO

ePWMx+1

ePWM Block Diagram

ePWM Block Diagram
EPWMCLK " Event Trigger |
I I
1 1
Clock Compare | ! | Compare | |
Prescaler Registers ! Registers [ !
Tiriz_-BBgse Compare Action Dead
TBCLK Counter Logic Qualifier Band _|
EPWMXxSYNCI EPWMxSYNCO .
Period
Register L —— EPWMxA
PWM Trip
Chopper Zone
EPWMxB
I_T { TZy
Digital ] 721723
INPUT X-Bar
Comparef*=— o\ x-gar
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ePWM Time-Base Sub-Module
ePWM Time-Base Count Modes

TBCTR

TBPRD

Asymmetrical
Waveform

TBCTR

TBPRD

Asymmetrical
Waveform

TBCTR

TBPRD

Symmetrical
Waveform

Count Up and Down Mode

ePWM Phase Synchronization

Ext. Syncin

Phase En _ Syncin

[#0 f—oZo—1— |epwmn,

CTR=zero
CTRECMPB +—0 0 |EPWMIB
X=—0
SyncOut

To eCAP1
Syncin

Phase Ep  Syncin

$=120° 0—0 EPWM2A

CTR=zero —0 A
CTR=CMPB *—0 O EPWM2B

X=—0 —

SyncOut

Phase Ep  Syncin

$=240° 0—0 EPWM3A
E—

Q
CTR=zero —0
CTR=CMPB *—0 © EPWM3B
X—o0 — . ‘“
SyncOut — ¢=240° —>

* Extended selection for CMPC and CMPD available
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ePWM Compare Sub-Module

ePWM Compare Event Waveforms

TBCTR | e = compare events are fed to the Action Qualifier Sub-Module |
TBPRD | e
CMPA - o b 8 g Asymmetrical

CMPB |---mmemepfmeee- bl )L Waveform

TBCTR

TBPRD

CMPA
CMPB

Asymmetrical
Waveform

Count Down Mode

TBCTR

TBPRD
CMPA Symmetrical
CMPB Waveform

Count Up and Down Mode

CMPC and CMPD available for use as event triggers

ePWM Action Qualifier Sub-Module
ePWM Action Qualifier Actions

for EPWMA and EPWMB

S/W Time-Base Counter equals: Trigger Events: gPWM
utput

Force | 700 | cmpa | cmpPB [TBPRD| T1 T2 Actions
S)\(N )Z( CXA CXB )Fz -I;él' 1;(2 Do Nothing
SlN f Cf\ CJ’B E -Iil -I:LZ Clear Low
SwW Z A CB P T1 T2 :

e CT AU A LA L] || SetHieh
SW Z CA CB P T1 T2 Toqal

T T T T T T T oggie

Tx Event Sources = DCAEVT1, DCAEVT2, DCBEVTL, DCBEVT2, TZ1, TZ2, TZ3, EPWMXSYNCIN

66 C2000 MCU 1-Day Workshop



Control Peripherals

ePWM Count Up Asymmetric Waveform

with Independent Modulation on EPWMA / B

TBCTR

TBPRD
CMPA

CMPB

|
|
r
1

R R
zl[P]| [cB CA zl[P] [cB CA P
M X | X d M X| | X J X

—>N

zl[P] [cB CA zl[P]| [cB CA zl[p
I X |4 X [T x| ¥ X | X

EPWMB Ii |

EPWMA

ePWM Count Up Asymmetric Waveform

with Independent Modulation on EPWMA

TBCTR

TBPRD
CMPB

CMPA
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ePWM Count Up-Down Symmetric
Waveform

with Independent Modulation on EPWMA / B

TBCTR

TBPRD
CMPB

CMPA

ePWM Count Up-Down Symmetric
Waveform

with Independent Modulation on EPWMA

TBCTR

TBPRD
CMPB

CMPA
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ePWM Dead-Band Sub-Module

gate signals are
complementary PWM

Motivation for Dead-Band

switch
device

¢ Transistor gates turn on faster than they shut off
¢ Short circuit if both gates are on at same time!

supply rail

to power

ing

ePWM Dead-Band Block Diagram

PWMXxA
E"""": Rising
! ; Edge
« H 0 S4E Delay :'""""‘ :'E)'""': """""
_E—Ko-i_p In Out = é 0 E _é'KSiL)_é_
P (14-bit) ~— S2iRED | j —o_S6 | PWMxA
H counter, : ! '
: e - ' 1 ——o
: h-I>o__(1) ' : ' 1

0

O

: S0 1

[: b 5

: . o !

[T [ (14bi POLSEL | OUT-MOD OUTSWA
IN-MODE counter)
HALFCYCLE

PWMxB
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ePWM Chopper Sub-Module

Purpose of the PWM Chopper

¢ Allows a high frequency carrier
signal to modulate the PWM
waveform generated by the Action
Qualifier and Dead-Band modules

¢ Used with pulse transformer-based
gate drivers to control power
switching elements

ePWM Chopper Waveform

EPWMXxA i
EPWMxB j |_
CHPFREQ il “W”H”W”wmm]
EPWMXAE : g | :
EPWMxB ﬂ_ﬂ |'”'|_|'|_|'| ”.”

OSHT StTW LY | :

With One-Shot Pulse on EPWMXxA and/or EPWMxB
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ePWM Trip-Zone and Digital Compare Sub-Module

Trip-Zone and Digital Compare Inputs

TRIPIN1 & TZ1
GPIO INPUT TRIPINZ & TZ2
> > TRIPIN3 & TZ3
MUX X-BAR TRIPING Trip-
TRIPIN4
TRIPINS - Zone
TRIPIN7 >
ePWM g TRIPINS Sub-
v TRIPING
X-BAR TRIPIN1O Module
DCAHTRIPSEL TRIPIN11 1 1
DCALTRIPSEL TRIPIN12
DCBHTRIPSEL [ __¥__, TZ4TZ5726
DCBLTRIPSEL : ] TRIPINL & TZ1
i ] TRIPIN2 & TZ2
i | TRIPIN3 & TZ3
! i TRIPING Digital
! ' TRIPIN4
2 ! ! TRIPINS Compare
j ] TRIPIN7 >
! ] TRIPINS Sub-
1 ] TRIPING
' : TRIPIN10 Module
. ' TRIPIN11
1 ] TRIPIN12 I
"""" TRIP COMBO TRIPIN14
TRIPIN15
|- CTRIPOUTH TRIPINA
CM PSS]. - CTRIPOUTL TRIPINS A”
TRIPIN7
. TRIPINS ePWM
TRIPING
: TRIPIN10 M d I
|- CTRIPOUTH TRIPINIL weltliEs
CMPSS8 L cTRIPOUTL TRIPINI2
INPUT1
INPUT2
INPUT3
| EPWM/ECAP sync l— EXTSYNCOUT ——>] INPUT2 INPUT X-Bar
INPUTS
[ ADCSOCAO  |— mocsoca — INPUTE
ePWM FLT1.COMPH 4
| ADCSOCBO |_ ADCSOCB ——»| - FLTL.COMPL
- ar L]
<_< ‘ L d
Ld
ADCA — EVILoEvTs —~—] FLTacomPH SD1
ADCB —— EVILOEVTd —my FLT4.COMPL -
ADCC — EVI1t0EVT4 —ep
ADCD — EVT1t0EVT4 —xz—
FLT1.COMPH 1
ECAP1 — EcaPLOUT —»] FLTL.COMPL -
ECAP2 —— ECAP2.0UT ——» ‘_q__l M
ECAP3 —— ECAP3.OUT —» . SD2
FLT4.COMPH
— Ecap40!
Lomps EAPROIT FLT4.COMPL -
ECAP5 —— ECAP5.0UT ——»
ECAP6 | — ECAP6.OUT —»] <—q‘_1
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ePWM X-Bar Architecture

TRIPXMUXENABLE

\ TRIPINX

*\...

TRIPOUTPUTINV

° o
L]
L]
g%% This block diagram is replicated 8 times
31.3
31.4
TRIPXMUX16TO31CFG.MUX31
MUX 0 1 2 3 MUX 0 1 2 3
0 CMPSS1.CTRIPOUTH | CMPSS1.CTRIPH_OR_CTRIPL | ADCAEVT1 ECAP1.0UT 16 SD1FLT1.COMPH SD1FLT1.COMPH_OR_COMPL
1 CMPSS1.CTRIPOUTL INPUTXBARL ADCCEVTL 17 SD1FLT1.COMPL
2 CMPSS2.CTRIPOUTH | CMPSS2.CTRIPH_OR_CTRIPL | ADCAEVT2 ECAP2.0UT 18 SD1FLT2.COMPH SD1FLT2.COMPH_OR_COMPL
3 CMPSS2.CTRIPOUTL INPUTXBAR2 ADCCEVT2 19 SD1FLT2.COMPL
4 CMPSS3.CTRIPOUTH | CMPSS3.CTRIPH_OR_CTRIPL | ADCAEVT3 ECAP3.0UT 20 SD1FLT3.COMPH SDIFLT3.COMPH_OR_COMPL
5 CMPSS3.CTRIPOUTL INPUTXBAR3 ADCCEVT3 21 SD1FLT3.COMPL
6 CMPSS4.CTRIPOUTH | CMPSS4.CTRIPH_OR_CTRIPL | ADCAEVT4 ECAP4.0UT 22 SD1FLT4.COMPH SD1FLT4.COMPH_OR_COMPL
7 CMPSS4.CTRIPOUTL INPUTXBAR4 ADCCEVT4 23 SD1FLT4.COMPL
8 CMPSS5.CTRIPOUTH | CMPSS5.CTRIPH_OR_CTRIPL | ADCBEVT1 ECAPS5.0UT 24 SD2FLT1.COMPH SD2FLT1.COMPH_OR_COMPL
9 CMPSS5.CTRIPOUTL INPUTXBARS ADCDEVTL 25 SD2FLT1.COMPL
10 CMPSS6.CTRIPOUTH | CMPSS6.CTRIPH_OR_CTRIPL | ADCBEVT2 ECAP6.0UT 26 SD2FLT2.COMPH SD2FLT2.COMPH_OR_COMPL
11 CMPSS6.CTRIPOUTL INPUTXBAR6 ADCDEVT2 27 SD2FLT2.COMPL
12 CMPSS7.CTRIPOUTH | CMPSS7.CTRIPH_OR_CTRIPL | ADCBEVT3 28 SD2FLT3.COMPH SD2FLT3.COMPH_OR_COMPL
13 CMPSS7.CTRIPOUTL ADCSOCA ADCDEVT3 29 SD2FLT3.COMPL
14 CMPSS8.CTRIPOUTH | CMPSSB.CTRIPH_OR_CTRIPL | ADCBEVT4 | EXTSYNCOUT 30 SD2FLT4.COMPH SD2FLT4.COMPH_OR_COMPL
15 CMPSS8.CTRIPOUTL ADCSOCB ADCDEVT4 31 SD2FLT4.COMPL

Trip-Zone Features

¢ Trip-Zone has a fast, clock independent logic path to high-impedance

the EPWMXxA/B output pins

¢ Interrupt latency may not protect hardware when responding to over
current conditions or short-circuits through ISR software

¢ Supports:

#1) one-shot trip for major short circuits or over
current conditions

#2) cycle-by-cycle trip for current limiting operation

CPU ]

P
core

Digital EPWMXxA W
ComFI’i"f EPWMXTZINT — M
(0]
INPUT X-Bar CEE by GEE > U
ePWM X-Bar Mode T
eQEP1—TZ4 EQEP1ERR EPWMXB B
SYscTRL—1Z5 CLOCKFAIL One-Shot > T
cpu—T26 EMUSTOP Mode S
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Purpose of the Digital Compare
Sub-Module

¢ Generates ‘compare’ events that can:
¢ Trip the ePWM
¢ Generate a Trip interrupt
¢ Sync the ePWM
¢ Generate an ADC start of conversion
¢ Digital compare module inputs are:
¢ Input X-Bar
¢ ePWM X-Bar
¢ Trip-zone input pins
¢ A compare event is generated when one or more
of its selected inputs are either high or low
¢ Optional ‘Blanking’ can be used to temporarily
disable the compare action in alignment with
PWM switching to eliminate noise effects

Digital Compare Sub-Module Signals

Time-Base Sub-Module

| pcaH Digital Trip DCAEVT1—>| Generate PWM Sync [

TRIPINL& TZ1, : — Egrenn;eﬁé PR Event-Trigger Sub-Module

TRIPIN2 & TZ2 ! 1 banking t—| Generate SOCA ||
TRIPIN3& 723, | Digital Trip |<— Trip-Zone Sub-Module /!

TRIPIN4 DCAL Egﬁ?tgé Trip PWMA Output ‘
, 2 l Generate Trip Interrupt | | !
* —» : i DCAEVT2 -

_ ‘ ‘
L4 e — ! I
« — Time-Base Sub-Module |
; DCBEVT1 5\
e e Digital Trp —| Generate PWM Sync | |
—_— . 1 !
Event-Trigger Sub-Module : |
TRIPINI4 [ someare Je-- E | Genegrite SOCB |
RPN | | 3 blanking - e
—_— ; Digital Trip |<.-._- Trip-Zone Sub-Module

TRIP COMBO DCBL E\é%]ga?g Trip PWMB Output .
Generate Trip Interrupt | ! }
‘ ‘ DCBEVT2 Co
DCTRIPSEL TZDCSEL DCACTL/ DCBCTL ----- !
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Digital Compare Events

¢ The user selects the input for each of
DCAH, DCAL, DCBH, DCBL

¢ Each A and B compare uses its
corresponding DCyH/L inputs (y = A or B)

¢ The user selects the signal state that
triggers each compare from the following
choices:

i. DCyH > low DCyL - don’t care
ii. DCyH - high DCyL - don’t care
iii. DCyL - low DCyH - don't care
iv. DCyL - high DCyH - don't care
v. DCyL = high DCyH - low

ePWM Event-Trigger Sub-Module
ePWM Event-Trigger Interrupts and SOC

TBCTR

TBPRD
CMPD
CMPC
CMPB

CMPA |7

creotp ot
CTR=PRD \ = i T i & ¢ | i o N O
CTR=0orPRO T+ L 1 ¢ T 0 © ¢ ¢ +
CTRU = CMPA | SN N S S B
CTRD=CMPA |
CTRU = CMPB |__ SRR L
cRo=cwea b
ctRu=ewpc i p b L i L b
ctRo=cmpc i 4 oA Ll
S STRC VT2 o O N T
CTRD=CMPD | | i | | | B EEE Y
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Hi-Resolution PWM (HRPWM)

Hi-Resolution PWM (HRPWM)

PWM Period
Regular
Device Clock JUuuvvrUUUrrrrUvruvvrivUuruiuuauun PWM Step
i i.e.10n
(-e. 00 MH2) | |y ¢ s)

(fixed Time-Base/2)
HRPWM divides a clock Calibration Logic tracks the

> aled wicro Stepe .~ msHmsHms~fnsHmsHme— S e e
(Step Size ~= 150 ps) | Calibration Logic | i variations caused by
Temp/Volt/Process

| HRPWM
LECEEEEETEEEEEEEEEEE TR Micro Step (=150 ps)

¢ Significantly increases the resolution of conventionally derived digital PWM

¢ Uses 8-bit extensions to Compare registers (CMPxHR), Period register
(TBPRDHR) and Phase register (TBPHSHR) for edge positioning control

¢ Typically used when PWM resolution falls below ~9-10 bits which occurs at
frequencies greater than ~200 kHz (with system clock of 100 MHz)

¢ Not all ePWM outputs support HRPWM feature (see device datasheet)

Capture Module (eCAP)

Capture Module (eCAP)

2
\|( Trigger .\_g

pin

Timestamp
Values

¢ The eCAP module timestamps transitions on a
capture input pin
¢ Can be used to measure the time width of a pulse

| tﬂj |

¢ Auxiliary PWM generation
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eCAP Module Block Diagram - capture Mode
CAP1POL
_,| Capture1 |__| | __| Polarity |__
Register Select 1
CAP2POL
|| Capture 2 |__| | Polarity |_|
Reglster o)) Select 2 PRESCALE
32-Bit 3 Event
Time-Stamp — < — Prescale | coam
Counter 2 CAP3POL ECAPX
Capture 3 o Polarity pin
—>| ) —]
CPUX.SYSCLK Register Select 3
CAP4POL
Capture 4 ] Polarity
Register Select 4 [

eCAP Module Block Diagram - apwm Mode

[ shadowed Period chadon
_ diat Period Register | “mode
Immediate i
mode Register (CAP3)
(CAPD)
32-Bit PWM
Time-Stamp Compare ———————
Counter Logic ECAP
pin
CPUx.SYSCLK
) diat Compare
M ode | Register |compare shadow
(CAP2) Register | “mode
| Shadowed (CAP4)
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Quadrature Encoder Pulse Module (eQEP)

What is an Incremental Quadrature
Encoder?

A digital (angular) position sensor

photo sensors spaced 0/4 deg. apart

V slots spaced 0 deg. apart _.9’4__
%@\\ rlight source (LED) i
o= o

—0 ch. A m
cne 1L LILL

shaft rotation

Incremental Optical Encoder Quadrature Output from Photo Sensors

How is Position Determined from
Quadrature Signals?

Position resolution is 0/4 degrees

(00) (11) increment decrement
(A,B) = | | counter @ counter
: 1 (10) 1(02)
| : | : A
IIIebaI
PR Transitions; , @
generate
phase error

|
|

|

|

|

|

|

l

| interrupt
T !

|

|

|

|

|

|

|

Ch. A

NG

Quadrature Decoder
State Machine

Ch.B
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eQEP Module Block Diagram
Quadrature

Measure the elapsed time

between the unit position events;

used for low speed measurement
Generate periodic Captu S

interrupts for velocity Quadrature - | | Direction -
calculations clock mode count mode
Monitors the quadrature

hEe]

clock to indicate proper

operation of the nl?lot?on w
32-Bit Unit L control system EQEPXB/XDIR

Time-Base RE: Quadrature|*
Decoder EQEPXI
T Watchdog L EQFEPX
CPUx.SYSCLK EQEPXS
l—— <

Position/Counter
Compare

Generate the direction and
clock for the position counter
[Generate a sync output in quadrature count mode

and/or interrupt on a
position compare match

eQEP Module Connections

Ch. A

Quadrature
[ Capture ~ ch.B &

EQEPXA/XCLK

32-Bit Unit
Time-Base [ | EQEPXB/XDIR

Quadrature
QEP — D,
i Waithdog ecoder EQEPX! Index

CPUx.SYSCLK EQEPXS Strobe

from homing sensor

Position/Counter
—  Compare
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Lab 3: Control Peripherals
» Objective

The objective of this lab exercise is to demonstrate and become familiar with the operation of the

PWM modules. In this lab exercise all the code will run on CPU1 (CPU2 will not be used).

PWM1A will be configured to generate a PWM waveform with programmable frequency and duty
cycle. PWMB5A will be phase locked to PWM1A and will share the same period, however its duty
cycle and phase offset are also programmable. PWM2 will be configured to generate a fixed 50

kHz sample trigger for ADC-A and ADC-C. These ADCs will sample the two PWM waveforms

and the results will be stored in two circular buffers in data memory. We will open two time graph
windows in CCS to observe the contents of these buffers while the PWM variables are adjusted.

PWM1A

connector
TB Counter e
Compare
Action Qualifier

ADCAO

ADCA

RESULTO
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PWML1 duty = programmable
PWMS5 period = synchronized
PWMS5 duty = programmable
PWMS5 phase = programmable

PWM2 triggering
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—
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View both
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Studio

Code Composer l

> Procedure

Open the Project

1. Aproject named Lab3_cpuO1l has been created for this lab. Open the project by clicking on

Project - Import CCS Projects. The “Import CCS Eclipse Projects” window will

open then click Browse... next to the “Select search-directory” box. Navigate to:

C:\F2837xD\Labs\Lab3\cpu01 and click OK. Then click Finish to import the project.

All build options have been configured the same as the previous lab.

Click on the project name in the Project Explorer window to set the project active. Then click
on the plus sign (+) to the left of Lab3_cpu01 to expand the file list.

Inspect the Project

2. Open and inspect Lab3_cpuO1.c. The initialization code immediately following main() is
similar to that used in lab 2. Notice the inclusion of the following three functions which

configure the PWM modules.
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IniteEPwm1()
InitEPwm2()
InitEPwm5()

The code for these functions is located further down in the same file.

Scroll down the file and locate the function InitEPwm1(). Inspect the code and notice the
following line:

EPwm1Regs.TBCTL.bit.SYNCOSEL = 1;

This configures the TB module to generate a SYNC output on a CTR = 0 match. Notice also
the setting of the PHSEN bit in the same register. This bit disables the SYNC input to this
module.

Scroll further down the file and locate the function Ini tEPwm5(). Inspect the code and
notice the setting of the PHSEN bit in this module. This bit enables synchronization from the
SYNC input from EPWM1.

At the bottom of this function are the following lines used to configure the AQ module:
EPwm5Regs.AQCTLA.bit.ZRO = 2;
EPwm5Regs . AQCTLA.bit.CAU = 1;

These define a HIGH output on a CTR = zero event and a LOW output on a compare match
when counting UP. The result is an asynchronous PWM with trailing edge duty cycle
modulation. ePWML is configured in the same way.

At the bottom of the file is the ADC Interrupt Service Routine adcal_isr(). Asinthe
previous lab exercise, this interrupt is triggered by an end-of-conversion (EOC) event from
ADC-A. The ISR code reads and stores the newest ADCINAO result in the buffer
AdcaResults and the newest ADCINC3 result in buffer AdccResults. Since ADC-A and
ADC-C are configured similarly, their conversion time will be the same and we only need one
ISR to collect both readings.

Notice the code near the bottom of the ISR which manipulates the variables pretrig and
trigger. The ISR code has been written so that the first sample in both buffers is taken on
a rising edge of PWM1A. When we view the results in a graph window, this makes it easier
to see the effects of changes to PWM duty cycle and phase offset.

Jumper Wire Connection

7.

We now need to connect the PWMZ1A output pin to the ADCINAO input pin, and the PWM5A
output pin to the ADCINC3 input pin. From Lab 2, one end of the jumper wire should still be
connected to connector J3, pin #30 (ADCINAOQ). Connect the other end of the jumper wire to
connector J4, pin #40 (PWM1A).

Using another jumper wire, carefully make a connection between connector J3, pin #24
(ADCINC3) and connector J8, pin #78 (PWM5A). Refer to the following diagram for the pins
that need to be connected using the jumper wires.
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Build and Load the Project

9. Click the “Build” button and watch the tools run in the Console window. Check for any errors
in the Problems window.

10. Click the “Debug” button (green bug). A Launching Debug Session window will open. Select
only CPUL1 to load the program on, and then click OK. The “CCS Debug” perspective view
should open, the program will load automatically, and you should now be at the start of
main(). If the device has been power cycled since the last lab exercise, be sure to configure
the boot mode to EMU_BOOT_SARAM using the Scripts menu.

Run the Code

11. Run the code by using the “Resume” button on the toolbar, or by using Run - Resume on
the menu bar (or F8 key). LED D10 should be blinking at a period of approximately 1
second.

12. Halt the code after a few seconds by using the “Suspend” button on the toolbar,or by using
Run - Suspend on the menu bar (or Alt-F8 key).

View the ADC Results

13. The Memory Browser should still be open from the previous lab exercise. If not, then open a
memory browser by clicking View > Memory Browser. Inthe box marked “Enter
location here”, type &AdcaResults and then enter.

Observe the contents of the AdcaResults buffer in the Memory Browser. If the code is
running as expected, you should see a series of readings close to 0, followed by another
series close to full scale (4095), similar to the first part of lab 2. This is the output from
PWM1A.

14. If the graph from the previous lab exercise is still open, close it now. Open and set up a Dual
Time graph to plot a 256-point window of both ADC results buffers. Click:
Tools - Graph - Dual Time and set the following values:

Acquisition Buffer Size 256

DSP Data Type 16-bit unsigned integer
Sampling Rate (Hz) 50000

Start Address A AdcaResults

Start Address B AdccResults

Display Data Size 256

Time Display Unit sample

Select OK to save the graph options.

15. We would like to be able to view both graphs at the same time. To do this, position the
mouse cursor on the tab of the graph DualTimeA-0, then click and hold down the left mouse
button while dragging the graph to a different part of the workspace. Choose an area where
both graphs can be viewed simultaneously before releasing the mouse button. The graphs
view should look like:
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16. The Expressions window should still be open from the previous lab exercise. If not, then click
the “Expressions” tab near the top of the CCS window. Add the following variables to the
Expressions window:

periodl
dutyCyclel
dutyCycle5
phaseOffset5

The other expressions are not needed for this lab exercise and can safely be deleted from
the Expression list, if desired.

(9= Variables & Expressions 33 | 181 Registers £ E | & R q&| CI ™ | & Y = 0
Expression | Type | Value | Address |
)= period1 unsigned short 50000 0x0000A306@Data
)= dutyCyclel unsigned short 12500 0x0000AB02@Data
)= dutyCycles unsigned short 12500 O0x0000AS03@Data
)= phaseOffsets unsigned short [u} 0x0000AS00@Data

57 Add new expression

Run the Code - Real-Time Emulation Mode

17. We need to enable the graph windows for continuous refresh. On the graph window toolbar,
left-click on “Enable Continuous Refresh” (the yellow icon with the arrows rotating in a
circle over a pause sign). This will allow the graph to continuously refresh in real-time while
the program is running.

18. Enable the Expressions window for continuous refresh using the same procedure as the
previous step.

19. Run the code and watch the windows update in real-time mode. Click:
Scripts > Realtime Emulation Control - Run_Realtime_with_Reset

20. Carefully remove and replace the connector wire to the ADCINAO input (connector J3, pin
#30). The ADC results graph A should be zero when the jumper wire is removed.

Next, carefully remove and replace the connector wire to the ADCINC3 input (connector J3,
pin #24). The ADC results graph B should be zero when the jumper wire is removed. This
confirms both buffers are updating in real-time.

Adjust the PWM Settings

21. We will adjust the PWM settings and check the effects in the graph. First, click on the
periodl variable value in the Expressions window and change its value to 30000. What
effect did this have on the PWM signals?

22. Restore the period1l variable to its original value of 50000.
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23. Next, change the duty cycle variables dutyCyclel and dutyCycle5 while observing the
PWM signals. In both cases be careful to choose a number between about 1000 and 49000.
Were the changes to the PWM signals as expected?

24. Now change the phaseOffset5 variable to a positive number between 0 and 49000. What
effect did this have?

25. Set the PWM variables as follows:
period1l = 50000
dutyCyclel = 25000
dutyCycle5 = 25000
phaseOffset5 = 25000

What is the relationship between these PWM waveforms called?

26. Finally, set the variable periodl to 75000. What happened and why?

27. Fully halt the CPU in real-time mode. Click:
Scripts > Realtime Emulation Control > Full_Halt

28. Run the code in real-time mode. Click:
Scripts > Realtime Emulation Control - Run_Realtime_with_Reset
Notice the original waveforms should now be displayed.

29. Again, fully halt the CPU in real-time mode. Click:
Scripts > Realtime Emulation Control -> Full_Halt

Terminate Debug Session and Close Project

30. Terminate the active debug session using the “Terminate” button. This will close the
debugger and return CCS to the “CCS Edit” perspective” view.

31. Next, close the project by right-clicking on Lab3_cpu01 in the Project Explorer window and
select Close Project.

End of Exercise
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Inter-Processor Communications (IPC)

IPC Features

Allows Communications Between the
Two CPU Subsystems

¢ Message RAMs

¢ IPC flags and interrupts

¢ |IPC command registers

¢ Flash pump semaphore

¢ Clock configuration semaphore
¢ Free-running counter

All IPC features are independent of each other

IPC Global Shared SARAM and Message SARAM
Global Shared RAM

¢ Device contains up to 16 blocks of global shared RAM
¢ Blocks named GSO — GS15

¢ Each block size is 4K words

¢ Each block can configured to be used by CPU1 or CPU2
¢ Selected by MemCfgRegs.GSXMSEL register

¢ Individual memory blocks can be shared between the

CPU and DMA
CPU1 Subsystem CPU2 Subsystem
Ownership
CPU1 CPU1.DMA CPU2 CPU2.DMA
CPU1 Subsystem* R/W/Exe R/W R R
CPU2 Subsystem R R R/W/Exe R/W

* default

There are up to 16 blocks of shared SARAM on F2837xD devices. These shared SARAM blocks
are typically used by the application, but can also be used for transferring messages and data.
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Each block can individually be owned by either CPU1 or CPU2.

CPUL1 core ownership:

At reset, CPU1 owns all of the shared SARAM blocks. In this configuration CPU1 core can freely
use the memory blocks. CPU1 can read, write or execute from the block and CPU1.DMA can
read or write.

On the CPU2 core, CPU2 and CPU2.DMA can only read from these blocks. Blocks owned by the
CPUL1 core can be used by the CPU1 to send CPU2 messages. This is referred to as “C1toC2".

CPU2 core ownership:

After reset, the CPUL application can assign ownership of blocks to the CPU2 subsystem. In this
configuration, CPU2 core can freely use the blocks. CPU2 can read, write or execute from the
block and the CPU2.DMA can read or write. CPU1 core, however can only read from the block.
Blocks owned by CPU2 core can be used can be used to send messages from the CPU2 to
CPUL. This is referred to as “C2toC1".

IPC Message RAM

¢ Device contains 2 blocks of Message RAM
¢ Each block size is 1K words

¢ Each block is always enabled and the
configuration is fixed

¢ Used to transfer messages or data between
CPU1 and CPU2

CPU1 Subsystem CPU2 Subsystem
CPU1 CPU1.DMA CPU2 CPU2.DMA

Message RAM

CPUL1 to CPU2 (“C1toC2") R/W R/W R R

CPU2 to CPU1 (“C2toC1") R R R/W R/W

The F2837xD has two dedicated message RAM blocks. Each block is 1K words in length. Unlike
the shared SARAM blocks, these blocks provide communication in one direction only and cannot
be reconfigured.

CPU1 to CPU2 “C1toC2" message RAM:

The first message SARAM is the CPU1 to CPU2 or C1toC2. This block can be read or written to
by the CPU1 and read by the CPU2. CPU1 can write a message to this block and then the CPU2
can read it.

CPU2 to CPUL1 “C2toC1” message RAM:

The second message SARAM is the CPU2 to CPUL or C2toC1. This block can be read or written
to by CPU2 and read by CPU1. This means CPU2 can write a message to this block and then
CPUL1 can read it. After the sending CPU writes a message it can inform the receiver CPU that it
is available through an interrupt or flag.
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IPC Message Registers

¢ Provides very simple and flexible messaging

¢ Dedicated registers mapped to both CPU’s

Local Register Local |[Remote | Remote Register
Name CPU CPU | Name
IPCSENDCOM R/W R IPCRECVCOM
IPCSENDADDR R/W R IPCRECVADDR
IPCSENDDATA R/W R IPCRECVDATA
IPCREMOTEREPLY R R/W IPCLOCALREPLY

¢ The definition (what the register content
means) is up to the application software

¢ TI's IPC-Lite drivers use the IPC message

registers

Interrupts and Flags

IPC Flags and Interrupts

¢ CPUlto CPUZ2:
¢ CPU2to CPUL1L:

Requesting CPU - Set, Flag and Clear registers

32 flags with 4 interrupts (IPC0-3)
32 flags with 4 interrupts (IPC0-3)

Register

IPCSET Message waiting (send interrupt and/or set flag)
IPCFLG Bit is set by the “SET” register

IPCCLR Clear the flag

Receiving CPU - Status and Acknowledge registers

Register
IPCSTS Status (reflects the FLG bit)
IPCACK Clear STS and FLG

When the sending CPU wishes to inform the receiver that a message is ready, it can make use of
an interrupt or flag. There are identical IPC interrupt and flag resources on both CPU1 core and

CPU2 core.
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4 Interrupts:

There are 4 interrupts that CPU1 can send to CPU2 through the Peripheral Interrupt Expansion
(PIE) module. Each of the interrupts has a dedicated vector within the PIE.

28 Flags:

In addition, there are 28 flags available to each of the CPU cores. These flags can be used for
messages that are not time critical or they can be used to send status back to originating
processor. The flags and interrupts can be used however the application sees fit and are not tied
to particular operation in hardware.

Registers: Set, Flag, Clear, Status and Acknowledge

The registers to control the IPC interrupts and flags are 32-bits:
Bits [3:0] = interrupt & flag
Bits [31:4] = flag only

Messaging with IPC Flags and Interrupts

CPU1 Memory Map IPC Registers CPU1 to CPU2 CPU2 Memory Map
PIE
Set
IPCSET y Q (IPC0-3)
Clear IPC Registers I
IPCCLR T IPCACK

R/W

cPuL H IPCFLG IPCSTS

R/W.
IPCSTS IPCFLG H CPU2
IPCACK l IPCCLR
T Clear
IPCSET
PIE Q S
(IPC0-3)

CPU2 to CPU1
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IPC Data Transfer

Basic IPC Data Transfer

¢ Basic option — no software drivers needed
and easy to use!
¢ Use the Message RAMs or global shared RAMs to

transfer data between processors at a known
address

¢ Use the IPC flag registers to tell the other
processor that the data is ready

CPU1 Application CPU2 Application

1: Write a message to .
CltoC2 MSG RAM Message 3: sees C1TOC2IPCSTS

_____, Dbitisset
CltoC2 MSG RAM

4: read message

C1TOC2IPCSET bit GSx Shared C1TOC2IPCACK bit

| ciToc2iPcFLG

The F2837xD IPC is very easy to use. At the most basic level, the application does not need
ANY separate software drivers to communicate between processors. It can utilize the message
RAM’s and shared SARAM blocks to pass data between processors at a fixed address known to
both processors. Then the sending processor can use the IPC flag registers merely to flag to the
receiving processor that the data is ready. Once the receiving processor has grabbed the data, it
will then acknowledge the corresponding IPC flag to indicate that it is ready for more messages.

As an example:

1. First, CPU1 would write a message to the CPU2 in C1toC2 MSG RAM.

2. Then the CPU1 would write a 1 to the appropriate flag bit in the CATOC2IPCSET
register. This sets the CITOC2IPCFLG, which also sets the CITOC2IPCSTS register on
CPU2, letting CPU2 know that a message is available.

3. Then CPU2 sees that a bit in the CITOC2IPCSTS register is set.

4. Next CPU2 reads the message from the C1toC2 MSG RAM and then

5. It writes a 1 to the same bit in the CITOC2IPCACK register to acknowledge that it has
received the message. This subsequently clears the flag bit in CL.TOC2IPCFLG and
C1TOC2IPCSTS.

6. CPUL can then send more messages using that particular flag bit.

88 C2000 MCU 1-Day Workshop



Inter-Processor Communications (IPC)

IPC Software Solutions Summary

¢ Basic Option
¢ No software drivers needed
¢ Uses IPC registers only (simple message passing)

¢ IPC-Lite Software API Driver
¢ Uses IPC registers only (no memory used)
¢ Limited to 1 IPC interrupt at atime
¢ Limited to 1 command/message at a time

¢ CPU1 can use IPC-Lite to communicate with CPU2
boot ROM

¢ Main IPC Software API Driver
¢ Uses circular buffers message RAMs

¢ Can queue up to 4 messages prior to processing
(configurable)

¢ Can use multiple IPC ISRs at a time

¢ Requires additional setup in application code prior
to use

There are three options to use the IPC on the device.

Basic option: A very simple option that does not require any drivers. This option only requires
IPC registers to implement very simple flagging of messages passed between processors.

Driver options: If the application code needs a set of basic IPC driver functions for reading or
writing data, setting/clearing bits, and function calls, then there are 2 IPC software driver solutions
provided by TI.

IPC-Lite:
e Only uses the IPC registers. No additional memory such as message RAM or shared
RAM is needed.
e Onlyone IPC ISR can be used at a time.
e Can only process one message at a time.
e CPUL1 can use IPC lite to communicate with the CPU2 boot ROM. The CPU2 boot ROM
processes basic IPC read, write, bit manipulation, function call, and branch commands.

Main IPC Software API Driver: (This is a more feature filled IPC solution)

Utilizes circular buffers in C2toC1 and C1toC2 message RAM'’s.

Allows application to queue up to 4 messages prior to processing (configurable).
Allows application to use multiple IPC ISR’s at a time.

Requires additional set up in application code prior to use.

In addition to the above, SYS/BIOS 6 will provide a new transport module to work with the shared
memory and IPC resources on the F2837x.
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Lab 4: Inter-Processor Communications
» Objective

The objective of this lab exercise is to demonstrate and become familiar with the operation of the
IPC module. We will be using the basic IPC features to send data in both directions between
CPU1 and CPU2. As in the previous lab exercise, PWM2 will be configured to provide a 50 kHz
SOC signal to ADC-A. An End-of-Conversion ISR on CPU1 will read each result and write it into
a data register in the IPC. An IPC interrupt will then be triggered on CPU2 which fetches this
data and stores it in a circular buffer. The same ISR grabs a data point from a sine table and
loads it into a different IPC register for transmission to CPU1. This triggers an interrupt on CPU1
to fetch the sine data and write it into DAC-B. The DAC-B output is connected by a jumper wire
to the ADCINAO pin. If the program runs as expected, the sine table and ADC results buffer on
CPU2 should contain very similar data.

CPU1 I CPU2
IPCO_ISR ! Sine Table
Reads IPCO data and writes into DAC-B I
DAC-B . b
IPCRECVADDR IPCSENDADDR £
@®— | DACVALS IPCO 3
Pin 11 _ . =
" - Q
| IPC1_ISR - .g
" 1. Reads IPC1 data %
sv?%necmr I and stores in circular E
ADCA1l_ ISR " buffer . ADC Resul
Reads ADC result and writes to IPC1 I 2. Writes next sine C Results
data to IPCO
ADC-A I
IPCSENDDATA IPCRECVDATA g
@— | RESULTO IPC1 3
Pin 09 - g
T ! - I=
g Toggle GPIO34 D9 @ 1 Hz I =
« Toggle GPIO31 D10 @ 5 Hz E
: I View ADC
buffer
I
PWM2 triggers "
ADC-Aat 50 kz I Code Composer
[ Studio

» Procedure

Open the Projects — CPU1 & CPU2

1. Two projects named Lab4 cpuO1 and Lab4_cpu02 has been created for this lab. Open
both projects by clicking on Project - Import CCS Projects. The “Import CCS
Eclipse Projects” window will open then click Browse... next to the “Select search-directory”
box. Navigate to: C:\F2837xD\Labs\Lab4 and click OK.

Both projects will appear in the “Discovered projects” window. Click Select All and click
Finish to import the project. All build options for each project have been configured the
same as the previous lab.
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Inspect the Project — CPUL

2. Click on the project name Lab4_cpuO1 in the Project Explorer window to set the project
active. Then click on the plus sign (+) to the left of Lab4 _cpu01 to expand the file list.

3. Open and inspect Lab4_cpuO1.c. This file contains two interrupt service routines — one
(ipcl_isr) to read the incoming sine data over IPC, and the other (adcal_1isr) to read the
ADC results. The code for these routines is located near the bottom of the file.

4. Inipcl_isr() incoming data from CPU2 is read via the IPCRECVADDR register. In
adcal_isr() the ADC result to CPU2 is written via the 1PCSENDDATA register. These
registers are part of the IPC module and provide an easy way to transmit single data words
between CPUs without using memory.

Inspect the Project — CPU2

5. Click on the project name Lab4_cpu02 in the Project Explorer window to set the project
active. Then click on the plus sign (+) to the left of Lab4 cpu02 to expand the file list.

6. Open and inspect Lab4_cpuO2.c. This file contains a single interrupt service routine —
(ipc2_isr) to read the incoming ADC data from CPU1 and write the next sine table point to
CPUL1. The code for this routine is located at the bottom of the file.

7. Inipc2_isr() incoming ADC data from CPUL1 is read via the IPCRECVDATA register, and
the sine data to CPUL1 is written via the IPCSENDADDR register. The IPCSENDDATA and
IPCRECVDATA registers are mapped to the same address on each CPU, as are the
IPCSENDADDR and IPCRECVADDR registers.

Jumper Wire Connection

8. We need to connect the DACOUTB output pin to the ADCINAO input pin, as was done in the
Lab2 exercise. Using the jumper wire, carefully make a connection between connector J3,
pin #30 (ADCINAO) and connector J7, pin #70 (DACOUTB). Remove all other jumper wires.
Refer to the following diagram for the pins that need to be connected using the jumper wire.

Build and Load the Project

9. Inthe Project Explorer window click on the “Lab4_cpu01” project to set it active. Then click
the “Build” button and watch the tools run in the “Console” window. Check for any errors in
the “Problems” window. Repeat this step for the “Lab4_cpu02” project.

10. Again, in the Project Explorer window click on the “Lab4_cpu0Q1” project to set it active. Click
on the “Debug” button (green bug). A Launching Debug Session window will open. Select
only CPUL to load the program on, and then click OK. The “CCS Debug” perspective view
should open, then CPU1 will connect to the target and the program will load automatically.
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11.

12.

13.

Next, we need to connect to and load the program on CPU2. Right-click at the line “Texas
Instruments XDS100v2 USB Debug Probe_0/C28xx_CPU?2” and select “Connect Target”.

With the line “Texas Instruments XDS100v2 USB Debug Probe_0/C28xx_CPU2” still
highlighted, load the program:

Run > Load - Load Program..

Browse to the file: C:\F2837xD\Labs\Lab4\cpu02\Debug\Lab4_cpu02.out and select
OK to load the program.

Again, with the line “Texas Instruments XDS100v2 USB Debug Probe 0/C28xx_CPU2" still
highlighted, set the bootloader mode using the menu bar by clicking:

Scripts > EMU Boot Mode Select -> EMU_BOOT_SARAM

CPUL1 bootloader mode was already set in the previous lab exercise. If the device has been
power cycled since the last lab exercise, be sure to configure the boot mode to
EMU_BOOT_SARAM using the Scripts menu for both CPU1 and CPU2.

Run the Code

14.

15.

16.

17.

In the Debug window, click on the line “Texas Instruments XDS100v2 USB Debug
Probe_0/C28xx_CPUL1". Run the code on CPUL1 by clicking the green “Resume” button. At
this point CPU1 is waiting for CPU2 to be ready.

In the Debug window, click on the line “Texas Instruments XDS100v2 USB Debug
Probe_0/C28xx_CPUZ2". As before, run the code on CPU2 by clicking the “Resume” button.
Using the IPC, CPU2 communicates to CPU1 that it is now ready. LED D10 connected to
CPUL1 on the LaunchPad should be blinking at a period of approximately 1 second. Note that
LED D9 connected to CPU2 will not be used in this lab exercise.

In the Debug window select CPU1. Halt the CPU1 code after a few seconds by clicking on
the “Suspend” button.

Then in the Debug window select CPU2. Halt the CPU2 code by using the same procedure.

View the ADC Results

18.

19.

If the graph from the previous lab exercise is still open, close it now. Open and set up a
graph to plot a 256-point window of the ADC results buffer. Click:
Tools = Graph = Single Time and set the following values:

Acquisition Buffer Size 256

DSP Data Type 16-bit unsigned integer
Sampling Rate (Hz) 50000

Start Address AdcaResults

Display Data Size 256

Time Display Unit sample

Select OK to save the graph options.

If the IPC communications is working, the ADC results buffer on CPU2 should contain the
sine data transmitted from the look-up table. The graph view should look like:
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Run the Code - Real-Time Emulation Mode

20. We will now run the code in real-time emulation mode. Enable the graph window for
continuous refresh. On the graph window toolbar, left-click on “Enable Continuous
Refresh” (the yellow icon with the arrows rotating in a circle over a pause sign). This will
allow the graph to continuously refresh in real-time while the program is running.

21. In the Debug window highlight the line “Texas Instruments XDS100v2 USB Debug
Probe_0/C28xx_CPU1". Run the code on CPUL1 in real-time mode by clicking:

Scripts > Realtime Emulation Control - Run_Realtime_with_Reset

22. Next, in the Debug window highlight the line “Texas Instruments XDS100v2 USB Debug
Probe_0/C28xx_CPUZ2". Run the code on CPU2 in real-time mode by using the same
procedure above.

The graph should now be updating in real-time.

23. Carefully remove and replace the connector wire from the DAC-B output (connector J7, pin
#70) or to the ADCINAO input (connector J3, pin #30). The ADC results graph should
disappear and be replaced by a flat line when the jumper wire is removed. This shows that
the data is being transmitted over the IPC from CPU2, and (after being sent from DAC to
ADC) received from CPUL1, also over the IPC.

24. Again, in the Debug window highlight the line “Texas Instruments XDS100v2 USB Debug
Probe_0/C28xx_CPU1". Fully halt the code on CPUL1 in real-time mode by clicking:

Scripts > Realtime Emulation Control -> Full_Halt

25. Next, fully halt the code on CPU2 in real-time mode by using the same procedure.

Terminate Debug Session and Close Project
26. The “Terminate” button will terminate the active debug session, close the debugger and
return CCS to the “CCS Edit” perspective view.

Click: Run = Terminate or use the Terminate icon: L

Next, close the Lab4_cpu01 and Lab4_cpu02 projects by right-clicking on each project in the
Project Explorer window and select Close Project.

End of Exercise
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Support Resources

Support Resources

C2000 MCU Multi-day Training Course

In-depth hands-on
TMS320F28379D
Design and Peripheral
Training

C2000 MCU Multi-day Training Course

TMS320F28379D Workshop Outline
- Architectural Overview

- Programming Development Environment

- Peripheral Register Header Files

- Reset and Interrupts

- System Initialization

- Analog Subsystem
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Experimenter’s Kit

¢ Part Number:

¢ TMDSDOCK?28379D
TMDSDOCK?28075
TMDSDOCK?28069
TMDSDOCK?28035
TMDSDOCK?28027
TMDSDOCK?28335
TMDSDOCK?2808
TMDSDOCKH52C1

JTAG emulator required for:
¢ TMDSDOCK28343
¢ TMDSDOCK?28346-168

L 2R 2R 2R 2R R AR 2

C2000 Experimenter Kit

¢ Experimenter Kits include
¢ controlCARD
¢ USB docking station

¢ C2000 Applications Software CD

with example code and full
hardware details

¢ Code Composer Studio

¢ Docking station features
¢ Access to controlCARD signals
¢ Breadboard areas
¢ Onboard USB JTAG Emulation

¢ JTAG emulator not required

¢ Available through Tl authorized

distributors and the Tl store

Perpheral Explorer Kit

TMDSPREX28335

F28335 Peripheral Explorer Kit

¢ Experimenter Kit includes

¢ F28335 controlCARD
¢ Peripheral Explorer baseboard

¢ C2000 Applications Software CD with
example code and full hardware details

¢ Code Composer Studio

¢ Peripheral Explorer features

¢ ADC input variable resistors

¢ GPIO hex encoder & push buttons
¢ eCAP infrared sensor

¢ GPIO LEDs, I12C & CAN connection
¢ Analog I/O (AIC+McBSP)

¢ Onboard USB JTAG Emulation

¢ JTAG emulator not required

¢ Available through Tl authorized

distributors and the Tl eStore
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LaunchPad Evaluation Kit

¢ Part Number:
¢ LAUNCHXL-F28027
¢ LAUNCHXL-F28027F
¢ LAUNCHXL-F28069M
¢ LAUNCHXL-F28377S
¢ LAUNCHXL-F28379D

C2000 LaunchPad Evaluation Kit

& Low-cost evaluation kit

¢ F28027, F28377S, and F28379D
standard versions

& F28027F version with InstaSPIN-FOC

¢ F28069M version with InstaSPIN-
MOTION

¢ Various BoosterPacks available

¢ Onboard JTAG Emulation
¢ JTAG emulator not required

¢ Access to LaunchPad signals

¢ C2000 Applications Software
with example code and full
hardware details in available in
controlSUITE

¢ Code Composer Studio

¢ Available through Tl authorized
distributors and the Tl store

Application Kits

C2000 controlCARD Application Kits

Developer’s Kit for — Motor Control,
PFC, High Voltage, Digital Power,
Renewable Energy, LED Lighting, etc.
Kits includes

+ controlCARD and application specific
baseboard

+ Code Composer Studio
Software download includes

+ Complete schematics, BOM, gerber
files, and source code for board and
all software

+ Quick-start demonstration GUI for
quick and easy access to all board
features

+ Fully documented software specific to
each kit and application

See www.ti.com/c2000 for other kits
and more details

Available through Tl authorized
distributors and the Tl eStore
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XDS100 / XDS200 Class JTAG Emulators
XDS100 / XDS200 Class JTAG Emulators

¢ Blackhawk ¢ Spectrum Digital
¢ USB100v2 ¢ XDS100v2

¢ Blackhawk ¢ Spectrum Digital
¢ USB200 ¢ XDS200
www.blackhawk-dsp.com www.spectrumdigital.com

C2000 Workshop Download Wiki
C2000 Workshop Download Wiki

Log in Request account

Page Discussion Read  View source View history |Search Q
{inms
INSTRUMENTS
Hands-On Training for TI Embedded Processors
Main Page The workshops available here offer hands-on training for Tl embedded processors. You can access
All pages the workshop materials from this site, organized by specific processor families. Many of these

All categories . ) .
waorkshops also include recorded online videos.

Recent changes
Random page

Help Workshop Descriptions and Materials
Print/export C2000™ 32-bit Real-Time MCU Training
CrEakez C2000™ One-Day Workshop - anline videos provided

Download as PDF

Printable version C2000™ Multi-Day Workshop

F2837xD™ Workshop
C2000™ Archived Workshops (F2407 / F2812 / F2808 / F28335/ F28027 / F28035 / F28069 /

F28M35x)

Toolbox
What links here
Related changes

http://www.ti.com/hands-on-training
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For More Information...

For More Information . ..

¢ USA - Product Information Center (PIC)
¢ Phone: 800-477-8924 or 512-434-1560
¢ E-mail: support@ti.com
¢ Tl E2E Community (videos, forums, blogs)
¢ http://e2e.ti.com
¢ Embedded Processor Wiki
¢ http://processors.wiki.ti.com
¢ Tl Training
¢ http://training.ti.com
¢ Tl eStore
¢ http://estore.ti.com
¢ Tl website
¢ http://www.ti.com

98 C2000 MCU 1-Day Workshop



Appendix A — F28379D Experimenter Kit

Appendix A — F28379D Experimenter Kit

Overview

This appendix provides a quick reference and mapping of the header pins used on the F28379D
LaunchPad and F28379D Experimenter Kit. This allows either development board to be used
with the workshop.

> Initial Hardware Set Up
e F28379D Experimenter Kit:
Insert the F28379D controlCARD into the Docking Station connector slot. Using the two (2)

supplied USB cables — plug the USB Standard Type A connectors into the computer USB ports
and plug the USB Mini-B connectors as follows:

e A:J1 on the controlCARD (left side) — isolated XDS100v2 JTAG emulation
e J17 on the Docking Station — board power

On the Docking Station move switch S1 to the “USB-ON” position. This will power the Docking
Station and controlCARD using the power supplied by the computer USB port. Additionally, the
other computer USB port will power the on-board isolated JTAG emulator and provide the JTAG
communication link between the device and Code Composer Studio.

Experimenter Kit and LaunchPad Mapping

Function Experimenter Kit LaunchPad
ADCINAO ANA header, Pin # 09 J3-30
ADCINC3 ANA header, Pin # 33 J3-24

GND GND J2-20 (GND)
GPI1018 Pin# 71 J1-4
DACOUTB ANA header, Pin # 11 J7-70
PWM1A Pin # 49 J4-40
PWM5A Pin # 57 J8-78
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Appendix A — F28379D Experimenter Kit

Stand-Alone Operation (No Emulator)

When the device is in stand-alone boot mode, the state of GPIO72 and GPIO84 pins are used to
determine the boot mode. On the control CARD switch SW1 controls the boot options for the
F28379D device. Check that switch SW1 positions 1 and 2 are set to the default “1 — on” position
(both switches up). This will configure the device (in stand-alone boot mode) to GetMode. Since
the OTP_KEY has not been programmed, the default GetMode will be boot from flash. Details of
the switch positions can be found in the controlCARD information guide.
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